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1. Technical data and requirements

REVELPROG-IS made by REVELTRONICS is a professional tool for serial memory programming. It supports wide range of EEPROM, FLASH and
FRAM devices with I2C, SPI, 1-wire and pWire protocols powered with 1.0V - 5.0V voltage levels. It has integrated ZIF socket (for THT devices)
and SOIC socket (for SMD devices). It has also connector for in-circuit serial programming (ICSP) with buffered I/O. Due to USB 2.0 interface

memory operations are really fast.

Technical data:

e power supply and communication via USB 2.0 (hardware level, bulk transfer),

e supported protocols: I12C, SPI, 1-WIRE, MICROWIRE,

e supported devices with 1.0V - 5.0V power supply,

e programming device powered from programmer (1.0 - 5.0V, Imax = 100mA) or from external circuit (1.0 - 5.5V),
e operation speed (read/write) up to 10Mbit/s,

e ZIF-32 + SOIC-8 (150mil) integrated sockets,

e connector for in-circuit serial programming (ICSP) with buffered 1/0,

e auto adaptive I/0 pins connected only for programming time (Hi-Z in IDLE state),

e short circuit and overload protection,

e device manufactured in EU, made in Poland.

Requirements:

e USB 2.0 or above,
e Windows 11, 10, 8, 7, Vista or XP (32 and 64 bit) + .NET Framework 4! installed in OS.

1 NET 4.0 Client Profile or above (can be downloaded from MICROSOFT: http://www.microsoft.com/en-us/download/details.aspx?id=17718 )
-6 -



http://www.microsoft.com/en-us/download/details.aspx?id=17718

2. Features and applications

REVELPROG-IS is used in many applications such as: car electronics & automotive (reprogramming modules, radio-code, mileage correction,
immobilizers, gps navigations), computer service (data recovery, reflashing/upgrading/programming BIOS chips on motherboards of PC, notebooks,
copier & fax machines, printers, SFP/QSFP/XFP transceivers etc.), RTV/AGD service (TV & TV tuners, digital cameras, multifunction devices etc.) and
many other devices equipped with serial I2C/SPI/MICROWIRE EEPROM and FLASH chips. Due to the possibility of change voltage level (in range of 1.0
- 5.0V) programmer supports both older and newer devices (e.g. latest devices equipped with 1.2V and 1.8V low-voltage chips). Device is equipped
with ICSP connector that allows in-circuit serial programming without unsoldering the chip from board - built in additional protection (buffered

I/0, short circuit and overload protection) increase reliability and safety of such operations.

Main features:

e reading / writing / erasing functions with user-friendly application interface,

e supported binary files (*.bin, *.rom, *.epp etc.) and Intel-Hex (*.hex) with possibility to load file to the buffer, edit it, calculate checksums,
swap-bytes, save modified bytes as patterns, compare with chip etc.,

e programming in socket or in external circuit (without unsoldering the chip),

e the target application device can be either powered by REVELPROG (possibility to change VPP and logic levels: 1.0V / 1.5V / 1.8V / 2.5V /
2.8V / 3.3V / 5.0V) or powered by an application with external power supply (1.0 - 5.5V),

e build in additional protection: buffered I/O pins internal connected only during programming + short circuit and overload protection (reduces
the risk of damaging parts due to connection mistake),

¢ integrated sockets (ZIF + SOIC) with auto adaptive I/O pins reduces requirement of additional adapters,

e short programming time?, e.g. WINBOND W25Q80BV (8Mb): read 0.9s (8,4Mb/s), write 3.3s (2,4Mb/s), MICRON N25Q128A (128Mb): read
12.8s (10Mb/s), write 37.6s (3,4Mb/s),

e useful tools such as: save/load patterns with changes, i2c/spi custom scripts, auto backups, file comparing etc.

2 Due to USB 2.0 hardware layer (BULK mode) maximum real transfer is up to 10Mbit/s for read/write operations but in many cases transfer is limited by read/write time cycle from/to
memory (e.g. write is always slower than read). Write time does not include chip erase time (you can find tCE in device datasheet) and verification (read) time. There is possibility to change
write sequence (e.g. without erasing and verifying) but most devices require at least chip erase before write operation.

-7 -



3. Installation of software and USB drivers

Requirements:

PC application is compatible with MS Windows3 11, 10, 8, 7, Vista and XP (32 and 64-bit versions). You will need also .NET Framework 4.0 to run
application (probably already installed* in your OS)

Software installation:

Software installation is typical for Windows. Just run setup (REVELPROG-IS_v1-x_Setup) and follow instructions (next, next, finish;). You may be

prompted for USB driver installation (accept it). Shortcut to REVELPROG-IS app will be added to the desktop. Application is ready to run.

Drivers installation:

In most cases drivers will be successful installed during application installation. Drivers may be installed also later from application (menu "help" ->

"install drivers").

Windows XP users will have to install drivers after first device plugged-in - just select drivers location in installation folder (by default it is
"C:\Program Files\REVELTRONICS\REVELPROG-IS\drivers\REVELPROG-IS"). If you miss it, you can install drivers later manually (run device manager,
find "REVLPROG-IS" device on the list, right click and update driver, select driver location).

Windows 8/10/11 x64 users will have to install drivers from REVELPROG-IS application by using "Zadig" installer (menu "help" -> "install drivers
with Zadig"). You should select REVELPROG-IS device on the list and install WinUSB driver, video: https://www.youtube.com/watch?v=6AFD3yBsRNc

3 Windows XP with SP3 installed (service pack 3). Windows 7 with SP1 installed.
In case of "fresh" install of OS you may need also "Microsoft Visual C++ 2010 Redistributable Package" (http://www.microsoft.com/en-us/download/details.aspx?id=5555)

4 if NOT, you can download and install it directly from Microsoft web page: http://www.microsoft.com/en-us/download/details.aspx?id=17718

-8 -



https://www.youtube.com/watch?v=6AFD3yBsRNc
http://www.microsoft.com/en-us/download/details.aspx?id=5555
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4. First steps with REVELPROG-IS application

4.1. User interface

Application interface is user-friendly. All main functions can be run directly from shortcut icons (all icons are actived after device connected). Please

move cursor above specific icon to see additional tooltip.
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Programator podiaczony (v1.3.0) CRC3Z .:




Memory buffer is displayed in hexadecimal + ASCII format. There is possibility to edit buffer as bytes and as ASCII characters.

Additional information is displayed in lower area: r. Revelprog IS (v1.3) =t

File. Edit View Settings Help

e buffer information: buffer size in bytes,

buffer addresses range and current Y St S
Dé 46 C3 FC 4C ED 05 8F 71 27 EB 59 16 CE 7C F5 OFlaLi..g'eY.i|8 a4
49 56 4B 98 BE O0E FD BC A7 11 25 45 4C 6A 2R E6  IVK.%.Y%uS.$ELj*&[ |
82 35 28 9A 03 D9 25 71 B7 8C F2 10 3B C7 96 94 .5(..0%q-.0.:C..
D9 69 24 C6 45 95 49 C7 AF 99 07 AB 66 70 59 9B Ui$ZE.IC ..«fpY¥.|=
4D 9D CO 85 DC 78 EC 63 6A 38 OF C2 F7 36 7D BF M.A.Uxinjs.i=6}¢|
CO 50 A9 15 41 5D B7 BB 7E 16 16 ED B3 E5 E6 18 AP®.A] -»~..i%3=.| |
C2 88 27 B3 FE 6D EA 1A 2E 3C FA DF E3 F2 C9 49 A.'*pbmé..<uB&0EI
84 7F 8B D4 9B D4 CS FA 58 C2 DB 97 4D 2B 18 A9 ...0.0Euxib.M+.e

A

address (or addresses range) of cursor
position (selection) with calculated

checksum-16 (from selected bytes),

e status bar (programmer version info or

o CE 57 B0 4D 94 6F OF 22 69 7D 8C 8E 1B 63 F5 7A 1IW M.o."i}...héz

last operation info), EC C3 1D 87 41 7B 60 D9 48 AE 03 E9 D2 39 1E 12  il..A{ UHe.&09..

9D BE 11 AF CD 43 B3 11 49 B5 C5 A9 3E 97 61 OF .%. fH®.Ipke>.a.

06 38 57 E4 22 E6 C6 A0 1B BD SE D7 63 96 09 88  .SWA"aE .M~xc...

e CRC-32 checksum calculated from buffer 9D C7 03 69 DC D7 8F 68 BC 71 C28 BC 70 13 4F 38  .C.ilx.h%qgE%p.0S
, , ) . 21 53 D5 D4 35 BE A8 8D 63 A7 E1 08 AS 63 CD B5  !5005% .c§a. cin

or opened file (click on "CRC32" to 81 CC A4 40 F8 OF C2 9F 75 12 DA 09 SA 04 ES 99 .in@w.A.u.0.Z.8.

D2 D8 D6 78 71 CO 15 DI 74 F5 A5 D8 CA 4F 44 B7 000xgd . Rt8¥2E0D -
3E 7F Cé 2D 5C F7 CE 21 EC CE 67 87 26 26 35 49 >.E-\+Itilg.zs&5I
F2 E2 3E 22 D4 BD 82 91 62 09 E7 56 76 A2 2C 20 0&>"0%..h.gVve,

2E 2E 2E 2E 40 2E 2E 2E 2E 2E 2E 40 2E 2E 2E 2E LB.... e
77 77 77 2E 52 45 56 45 4C 54 52 4F 4E 49 43 53 WW . F 5
2E 63 6F 6D 2E 2E 2E 2E 2E 2E 2E 2E 2E 2E 2E 2E
2E 2E 2E 52 45 56 45 4C 50 52 4F 47 2D 49 53 2E Lo IS.
2E 40 2E 2E 2E 2E 40 2E 2E 2E 2E 2E 40 2E 2E 8 R el T

recalculate checksum)

DA NNTTIN N o "D 0 14 NnL 12 ng aD ) A A A D aD cc e ] an A D7 TTAD o
Address: 0130 - 0x15F (48 bytes, checksum-16: 0x0CFF)

Buffer size:  0x0 - 0:x3FB {1020 Bytes}

Programmer is connected (v1.3.0) CRC32: 0x2C5C9062 .:
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4.2. Device programming

Device type should be selected from the device database before any operation ("chip select" icon). Voltage will be set automatically. It can be
changed manually by clicking VPP icon. In case of ICSP programming with external power supply, VPP should be set to the same level as memory

power supply.

r N
B Revelprog IS {v1.3) |= =] &
4.2.1. Reading
File Edit View Settings Help
: ¥ Z \ 3 oo
Before device reading operation, memory type should be peret * ey | i l ol > =
C LB | Fog®V = & S8 A4 2

chosen. Please check also VPP voltage (you may need to
change it in case of low-voltage chips). Click READ icon

(memory chip with green arrow).

Programmer will read device. Memory content will be loaded Reading [ 84% |

e

Reading ... (8738.1 kb/s)

into the buffer. Buffer can be saved to external file. You can

also edit the buffer and reprogram the device.

Please note at the CRC32 checksum (right corner at the
bottom). If checksum is equal after each read than the risk of
read with error usually does not exist. It is a good practice to

make memory backup to external file before any writing.

2
-
2

The reading may be incorrect due to communication error or

broken chip.

Reading ... (3029.4 kb/s) CRC32: 0x091BA3E3 .:

-11 -



4.2.2. Writing

Before device programming operation, (1) memory type should be chosen and (2) buffer should be filled with data. You can load data from external
binary (*bin, *.rom, *.epp etc.) or Intel-Hex (*.hex) file. Please check also VPP voltage - it may be changed in case of low-voltage chips. Please click

“WRITE” icon (memory chip with red-orange floppy disk).

"
, : . B Revelprog IS (v1.3) = B X
Programmer will erase the device, write data to memory from e

File- Edit View Settings. Help

the buffer and make verification process. There is possibility to

change writing sequence from menu: Settings -> Write

sequence. Verification process will read the device after writing

and compare reading with the buffer. If verification pass than
memory is successful programmer. Verification error may occur

due to communication error, secured or broken chip.

4.2.3. Erasing

To erase memory, empty buffer can be loaded and

programmed into a memory. In most cases this operation is not
necessary, because programmer supports fast erase procedures
(Page Erase, Block Erase and Chip Erase). Please click "ERASE”

icon (memory chip with OxFF and broom) for erasing operation.

(Al ¥ L I SN SR S R L B SN - B N |

Please note that erasing progress is not displayed at progress
bar. For high density FLASH memories erase process may took

quite |0ng (even few minutes!)_ Programming... (2440.7 kb/s) CRC32: 0x891BA3E3 .:
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4.3. HEX editor features (buffer editing)

4.3.1. HEX editor

Buffer can be edited from application level. In

the first column there is current address
displayed. In the second column there is memory
in hexadecimal
is ASCII

representation of memory contents. All buffer

contents displayed (as bytes
mode). In the third column there
operations are allowed (e.g. CTRL+C, CTRL+V
etc.). Modified buffer can be saved to external

.bin or .hex file.

4.3.2. Appearance

There is possibility to personalize hex editor,
e.g. color and font changes. Bigger font and dark
contrast colors will enhance your work with editor

especially on high resolution displays.

File

Edit

00000000
00000010
00000020
00000030
00000040
00000050
00000060
00000070
00000080
00000090
000000A0
000000BO
000000C0O
000000DO
CO00000EO
000000F0

Address:
Buffer size:

View  Settings Help
& . Ve
01 02 03 04 05 06 07 08 09

00
FF

54
FF

_lGeneral'i-Hardwareji_“ Apperance
Buffer {Hex Editor}
Colors

General
Background: _
Font: [ |
Header: [ |

Courier New, 11.

0x30 - 0x5F (64 bytes, checksum-16: 0x3BE4)
0x0 - OxFF (256 Bytes)

&) ‘ OXFF ] . ,@
OEBRE S
OD OE OF

FE
FF

oa OB OC

01
EF

54
FF

01
FF

AB AB

Load template

-Th« .Th«.

Selected area L Light

Background: l:]

Light (enlarged)

Font: NI ‘

Edited area

Font: [N

Dark (enlargedj

J

Cancel

Wi\Workidumps\93¢56\scenic.bin®

Pregrammer is connected (v1.5.0)

CRC

o A S

32: 0xBEAOBA34
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4.3.3. Fill buffer...

Fill selected bytes with constant bytes or defined pattern.

1. Open context menu (right click) and choose fill... 3. Take profit - you have just saved some time...

08 09 0A OB 0C OD OE OF
00000000 90 22 02 00 6D DD 90 22
00000010 54 FE AB 01 54 FE AB 01
00000020 Cut
00000030

File Edit View Settings Help

00000040 fcpy
00000050 Paste
00000060 Fill...
00000070 il — ! 00000000
00000080 ( Load changes from pattern... 00000010 5 Bp« . Tp.
00000090 ! Save changes as pattern... 88388823 .
000000A0
Select all 00000040

00000080

00000050
00000060
00000070
00000080
00000090
00000040
00000080
000000CO
000000D0O
000000EQ YYVYYYVyYyyyyyyy
000000F0 YYYYYyyyyyyyyyyy

03 04 05 06 07 08 09 O0a OB 0OC OD OE OF

00000000 22 02 00 6D DD 90 22 02 00 6D DD 90 22
00000010 DD 90 22 02 00

00000040 .
00000050 F F ¥ ; 5 0x00 @ Pattern

00000080
00000090

000000C0O
000000DO
000000E0D
000000F0

Address: 0x13
Buffer size:  0x0 - OxFF (256 Bytes)

Work\dumps\93¢56\scenic.bin*

Programmer is connected (v1.5.0)
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4.3.4. Patterns - export changes to file

All manual changes (highlighted bytes) can be exported to external file (pattern). Later, at any moment there is possibility to load pattern file and all

changes will be imported, without modifying other bytes in the buffer. Simple, fast and powerful.

00 01 02 03 04 05 06 07 08 09 0A OB OC OD OE OF

00000000
00000010 4 Fp«.Tp«.
00000020 VIV
00000030 Coibiy TV . . TV
00000040 )
00000050
00000060
00000070
00000080
00000090
00000020
00000080
000000C0
000000D0
000000E0
000000F0

Fill...

Load changes from pattern..,

Save changes as pattern...

O OO N K

Select all YYyy - -yYVVyyyy- -
- pi...W)...E..y.v

(=}
(=}

00 35 01
FF- FF FF
FF FF FF

B |
o

4.3.5. Swap bytes
Swap bytes operation will change byte order in 2-bytes word. For example, swapped word OXABCD will be equal to OXCDAB. This functionality is very

useful for memories with two addressing modes, e.g. for microwire 93... series 16-bit chips. REVELPROG supports both addressing modes (8-bit and 16-

bit) for these devices.

File Edit View Settings Help File Edit View Settings Help

— .

ya o1 03 04 05 06 07 08 09 0A OB OC O I .
01 23 45 67 89 AB CD EF 01 23 45 67 89 AB EF .#Eg.«Ii.#Eg.«fi "g;“'f¥*‘?§“‘¥¥{ e
01 23 45 67 89 AB CD EF 01 23 45 €7 89 AB CD EF  .#Eq.«li.#Eg.«li $-OE%-Tl¥gBk. 1l
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4.3.6. Clear buffer or generate random buffer

There is possibility to clear buffer (OxFF) or generate random buffer from Edit menu. Buffer length will be equal to memory size. CTRL + N shortcut

will clear buffer and CTRL + N shortcut will generate random buffer.

4.3.7. CRC32 and Checksum-16

Click "CRC32" in right-bottom corner to calculate CRC32 checksum from the buffer. Changing single byte in the buffer will change CRC32 checksum
so this feature is useful in comparison of sequential reads or files. Checksum-16 is calculated in real time from selected bytes in the buffer area and it's

displayed in buffer info. This is most common algorithm for checksum used in wide range of devices (checksum of mileage, operation hours, serial

numbers etc.) To calculate Checksum-16 from all addresses select all bytes in the buffer area (CTRL+A).

File Edit View Settings Help

|:j.;:| @. 'WPP . i 2 : j0x7 S <7 U 5UF
' Zhet 95.160 1£ 5V S S O N

oL

a
=
)
1)
{\
o

o)
ke
o3]
¢
'~
e
=
%
>

B5 50 CF EC BB 54 B7 7B 50 42 29 11 OF OF aAa 3D RPIi»T - {PB)...3%=

.K..®.BD®.a.~¥Ij
(.TY&00a:a¥ % 1xn
sp. . **t] . . . <HO¥U«
t.en%i. 'T;MEZ4E. .
AR 2% . E.5vwA%D.3Q6.
E9 F9 E9 34 B7 7B E9 a6 9D 5F 42 89 64 95 4D 29 éuéd {&}. B.d.M)
71 02 2¢ Fa 35 07 22 8¢ 3F 11 71 30 95 FC 7B F4 03 ..15.2.2.00.1{8.
Address: | 0x20 - 0x5F (64 bytes, checksum-16: 0x223F)
Buffer size: 0x0 - 0x7FF (2 KB)

-

| Programmer is not connected. !CRCBZ: 0xD3D4&FDF I;;

4.3.8. File format conversion: .bin <-> .hex

I Application can be used also as a simple file converter (binary to intel-hex and vice versa). To convert file from one type to another, just open file

(load to buffer) and save it in another format.

-16 -



4.3.9. DiffChecker (file comparing)

DiffChecker tool allows to compare 2 bin or hex files. All differences will be selected and grouped. Press F3/F2 to find next/previous difference region.
You can save all differences to external file as a pattern (feature described in Chapter 4.3.4). If files are totally different then first 1000 different

regions are marked.

& DiffChecker — a *
Tl' WiWorld dumps\93c56iscenicl .bin 256B ((A48E) .-
00 01 02 03 04 05 06 07 08 09 3A 0B 0C 0D OE OF ~

) 00000 22 mf.,~,.my."~..my_ "

00010 01 54 FE 2B 01 LY ", Tphe.Th«.

0oo000z0 0% 00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF  ..9{yuyivyvivsyy

goooooio  FF OFF FF FF FF FF 0% 00 FF FF FF FF FF FF  §9¥{yv..iyivvey

FF FF FF FF FF FF FF FF FF FF FF FF [EEMFF FF  §90000 009007, . 97

FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF ¥V ¥ivvivvvvveyy

FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF  §{{0ivovvvvvevsy

FF FF FF FF FF FF FF FF FF FF FF FF FF FF D9 3D  §{{ievevvvvvysn=

00 05 01 00 01 00 1E 18 00 3B 06 6B DO 3D 00 05 eeeeenaan p.il0=..

01 00 01 00 1E 18 00 3B 06 62 03 00 FF FF FF FF viuuenn Pede . TEEE

FF FF FF FF 03 00 FF FF FF FF FF FF FF FF 1B 12 §YYY. . STEEEEEE. .

BS EE 13 00 06 57 29 g2 FF 56 pi...W)...E..7.V

46 31 4B 4D 30 47 44 5 33 35 3u 3q 35 34 3q 31 F1JMoGDE35095491

35 1% 82 00 00 05 O1 46 00 00 35 01 53 02 FF FF S.uuewn. F..5.5.%%

FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF  §9¥iyvoivvevvesy
000 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF  §VViivvivoviveiy v
il' WiWorlh dumps\93c56hscenic2. bin 2568 ((xATOB) .:
00 01 02 03 04 05 06 07 08 0% 0R OB OC OD OE OF ~

lz¥.3.}z¥.3.})=zY.

54 AB 01 54 FE 01 3.}z¥.3.Tb«.Tb«.

09 00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF .. ¥00yyvvvvvvvy

FF FF FF FF FF FF 09 00 FF FF FF FF FF FF  §9¥9¥¥..Vvvivvy

FF FF FF FF FF FF FF FF FF FF FF FF EEOEENIFF FF  §99 09009 vev1C97

FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF {9V iyvivvvvvvvy

FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF  §9i00diivvvvivi

FF FF FF FF FF FF FF FF FF FF FF FF FF FF D9 3D  §9i9idvivvvvivl=

00 05 01 00 01 00 1E 18 00 3B 06 62 D9 3D 00 05  evueuwanas ;.i0=..

01 00 0L 00 1E 18 00 3B 06 6% 03 00 FF FF FF FF  evuennun Pade . FEET

FF FF FF FF 03 00 FF FF FF FF FF FF FF FF 1B 12 V. - TPV .

B5 EE 13 00 08 57 28 56 pi...HW)...EBE..7.V

000000C0 46 31 4R 4D 30 47 44 FIETIECIEPIECEEPIEEEETN:1 F1.MoGD243252341

000000 nu 35 19 82 00 00 05 Ol 46 00 00 35 01 53 02 FF FF 5.ueuun F..5.5.9%

- FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF 07009070 00o090¢
000000F0 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF  GVV00Tvi000v9997 v
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4.4, Additional features

4.4.1. Blank test

Blank test checks if chip is empty. Test will be canceled as soon as first programmed cells will be detected (there is no need to read full memory).

4.4.2. Compare with the buffer

Operation compares buffer with the contents of memory. Operation will be cancelled as soon as first difference will be detected.

4.4.3. VPP selection

VPP is set for both: programming voltage and signal levels. VPP can be changed with 0.1V step in range of 1.0 - 5.0 volts. This feature is very useful

in few cases:

e in order to program low-voltage variant of the device (e.g. 1.8V instead of 3.3V),

e in case of in-circuit programming with external power supply -> programmer voltage should be the same as external circuit voltage or VPP
should disabled (VPP OFF),

e in case of in-circuit programming without external power supply. In many cases there is no need to set nominal voltage for external board. For
example: memory operates in range of 2.6 to 3.6 volts. Nominal voltage for external board is 3.3V. Setting the lowest operational voltage (2.6V)
will be enough to power and communicate with the memory and at the same time will be too low to power all circuits around. First of all, if there
is main microprocessor on the board than it will not communicate with the external memory (because it will be in "reset" state due to low
voltage to operate) so it will be possible to communicate with this memory using external programmer. Secondly, you will save current
consumption because devices in reset state consume much less power. This trick is not always possible, so if you can't communicate with the
device in external circuit try to plug-in external power supply or unsolder the chip and program it in socket. Please read Chapter 5 for more

details.
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4.4.4. Device identification (Chip ID) for FLASH SPI, DATAFLASH and 1-wire devices

In order to read Chip ID please select “Tools” -> “Read ID” (F10). Operator should know operating voltage for the device because REVELPROG-IS
supports also low voltage chips and reading chip ID without knowledge about chip power supply level is risky (setting 3,3V for 1,8V chip will damage it
even during chip id reading). For FLASH devices programmer will read 4 identification bytes of data (JEDEC ID)- 15t byte is Manufacturer ID, 24 and 3™
bytes are Device ID and 4™ byte is Extended ID. For some FLASH SPI devices programmer can auto select recognized chip from memory database. You

can read about identification bytes in device datasheet. For 1-wire devices programmer will read 64-bit unique identification number.

4.4.5. Quad SPI (QSPI) configuration for FLASH SPI

Some of FLASH SPI devices may require to enable QSPI mode before soldering it in external device. This will require to change one of configuration

or status registers in device memory map.
TIP: in most cases, specially when you reprogram FLASH SPI there is not necessary to change any configuration bits.

To enable or disable Quad mode you can use dedicated tool (Tools -> Quad SPI) - it will work with most popular FLASH SPI devices (e.g. Winbond
and Spansion). For other devices it may be necessary to write custom script (with Custom Script tool - described in Chapter 6) to enable or disable

QSPI mode manually by changing QSPI bits in required registers. You can read how to change Quad SPI mode for your device in device datasheet.

4.4.6. SFP/QSFP/XFP Transceivers support

REVELPROG-IS has dedicated tools for optical transceiver support. There is SFP/QSFP/XFP adapter required with external power supply. MSA
Standard is supported (e.g. SFF-8472, SFF-8636, INF-8077i). Dedicated functions allows to enter manufacturer/host password and program write
protected transceivers, brute force password (searching password for protected transceivers with unknown password), change manufacturer info,

model, serial number etc. and recalculate checksums directly from REVELPROG-IS application. Please check Chapter 7 for more details.

4.4.7. Auto backup

Every read operation there is backup file (.bin) generated (by default it is user documents folder in system). By default maximum 16 files are
created (oldest are deleted) and size is limited to 8Mbit devices. You can change these parameters in Settings -> Option -> File -> Autobackup (you
can set unlimited number of files and size).
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4.4.8. Custom Scripts for SPI, 12C, 1-Wire

Custom Script Tool allows to execute user defined commands on SPI, I12C or 1-Wire bus, e.g. unclocking device, read/write custom registers, change
sector protection bits, write OTP registers and much more. Please check Chapter 6: Custom Script Programming (I2C / SPI / 1-wire bus) for more
details or forum tutorial https://forum.reveltronics.com/viewtopic.php?f=22&t=280 with examples.

4.4.9. W74Mxx Secure Authentication Flash

Authentication Flash W74M series is standard W25Q series Flash with additional layer for authentication. With W74xx Authentication Flash Keys Tool
for REVELPROG-IS it is possible to programm new keys, verify if used key is correct (authentication pass) or increment monolitic counter. It is NOT
possible to read stored keys. More information about W74M series and programming keys:

https://forum.reveltronics.com/viewtopic.php?f=32&t=972

4.4.10. Automatic mode with production file and command line (Beta)

REVELPROG-IS application is GUI based application so Automatic Mode tool is also GUI based. It will not work from command line interface, but it can
be started from command line interface with additional parameters. It is possible to run REVELPROG-IS application from command line with
-productionFile "path.txt" parameter, so it will run and load production file on start-up. In production file it is possible to configure: device name,
operating voltage, operation type (READ, WRITE or ERASE), file path (for write or read operation), pre-script and post-script paths (for custom script
tool). Please read below tutorial with video example how to use automatic mode tool:

https://forum.reveltronics.com/viewtopic.php?f=32&t=913&p=3822
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5. In-Circuit Serial Programming (ICSP)
Caution! Before ICSP programming please read following instructions!

ICSP programming is recommended only for advanced users. There is required technical knowledge and being familiar with specific chip. You should

read carefully device datasheet, especially memory pinout, addressing modes and voltage levels.

Programmer is equipped with 10-pin ICSP socket (IDC10). There’s only 8 pins used (pin-9 and pin-10 are not internally connected). Pinout

numeration (1-8) is the same as memory pinout in datasheet for DIL8/S08 package.

There will be various signals at these pins during chip programming (digital and analog signals). These signals are assigned automatically after

memory chosen (in application) and are set only during memory operation.

5.1. Addressing in external circuit

All hardware addressing outputs for EEPROM 24.. series (pin 1,2,3 ie A0, A1, A2) must have low voltage level (GND). If chip in circuit is addressed in
other way (e.g. there are few the same chips, which require various addressing) then communication will fail. In this case you can (1) set correct
addressing in application (“"External addressing” option during memory selection) or (2) set default “"0” addressing with the programmer (connect

addressing wires to the chip and in the same time disconnect them in external circuit) .The safest option is to unsolder the chip and put it to integrated

programmer socket.

Addressing 8/16-bit for EEPROM 93 series also needs special care. In circuit addressing wire (pin 6) can be connected to low or high state (it's
defining addressing mode if memory support both modes). Depends on your chip selection in application (8/16 bit) programmer gives LOW or HIGH
state on this pin. If you choose wrong addressing (e.g. in circuit it is low state and programmer outputs high state) than you will make short circuit. In
most cases it's not necessary to connect addressing wire (pin 6) for microwire 93 series - it's enough to select right mode from application (16-bit in

most cases).

If you are not 100% sure about connections, DO NOT program in circuit - unsolder the chip and program it with integrated socket.
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5.2. Write protection in circuit (WP/PRE pin)

A lot of serial devices have WP (Write Protect) or PRE (Protection Enable) input. Low state on this pin (ground) protect the device from erasing and
writing. Programmer outputs a high state during erase or write operation. If in external circuit write protect pin is connected to ground (common case),
and programmer will output high state on this pin, than it will lead to short circuit. There are 3 common solutions in this case: (1) do not connect write
protect pin (erase/write will not work), (2) disconnect write protect pin in circuit (connect it only to programmer) or (3) unsolder the chip and

programm it in programmer's socket.

WP (Write-Protect) or PRE (Protection Enable) pin can be found e.g. in FLASH SPI 25.. (pin 3), FLASH SPI 26... (pin 3), FLASH SPI 45... (pin 5),
EEPROM I2C 24... (pin 7), EEPROM SPI 25.. (pin 3), EEPROM SPI 35... (pin 3), EEPROM SPI 95... (pin 3), EEPROM MICROWIRE 93... (pin 7).

5.3. Power supply in external circuit

The target application device can be either powered by programmer [voltage level (VPP) can be chosen from: 1.0V - 5.0V - please read Chapter
4.4.3] or powered by an application within a voltage range of 1.0V to 5.5V. If chip is already powered in external circuit, than VPP should be set to the
same voltage as external power supply (0,1V accuracy is tolerated). Absolute maximum rating at programmer's I/O pins is 5.5V - exceed this value

may damage protection buffers in programmer.
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5.4. Limits and possible issues during in-circuit programming

In some cases there is no possibility to program chip in application. This can be due by many reasons, such as:,

to long signal wires,

too much load capacity in circuit,

incorrect pull-ups or pull-downs on signal wires,

incorrect addressing,

bus conflict (memory is during communication with other device),
impedance not match,

additional capacitors, diodes bus-switches etc. in circuit.

In case of power supply from programmer, current is limited to 100mA for
safety reason. If application requires more power, than external power

supply should be connected.

In case of incorrect connections, short circuit or overload, following error
(pict.) will be displayed and all I/O will be disconnected. Delay of protection
trigger is 5-35ms so you still have to be careful. Programmer implements
"VPP-boost" mode which allows for 3x higher current consumption at the
first 30ms of operation (e.g. for capacitor charging). There is also possibility
to increase in settings overload protection to 200maA.

If you are not sure about connections or voltage levels DO NOT
program in-circuit. It is much safer to unsolder the chip and

program it in the socket.
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»
Critical error.

To much

NOTE - too much current consumpticn! (>100mA),
For safety reason operation was canceled,

Possible causes:
a) if programming in integrated memory socket:
L shorted circuit or faulty memory
-> please check connections,
b} if ICSP programming:
1. shorted circuit or incorrect connections,
L. too much current consumption
-> disconnect unnecessary loads or...
-> connect external power supply or...
-> place memory in integrated socket,
I conflict voltage
- if device has external power supphy:
-> disable VPP in application (VPP = OFF) or...
-> disconnect external power supply.

Operation canceled {too much current)




5.5. SOIC Clip

Devices in SOIC package can be connected with SOIC CLIP (e.g. POMONA 5250 for SOIC-8 and POMONA 5252 for SOIC-16). Programming with a clip
is recommended only for advanced users (many traps for young players). Clip is a precision measuring device - before connecting the clip please
read chapters 5.1 - 5.4. Please follow tips below to avoid any accidental

damage to the clip:

e clip should be used only with SMD chips with SO-8 package (150mil
or 200mil),

e clip should NOT be used with physically damaged chips (not straight
pins or excess of tin),

e do NOT touch contact pins — any attempt of mechanical interference
will damage contact pins,

e it is NOT recommended to use the clip when device was previously
soldered in not professional way (pins may not contact to memory

pads; there is also risk of damage to the contact elements). In such

case it is recommend to use external adapter SOIC-8 150mil or
SOIC-8 200mil,

e it is NOT recommended to use the clip on a desoldered device (“in air”) - read and write may be incorrect (specially for fast devices, e.g. FLASH
SPI). All devices should be programmed in external circuit or in adapter, because only this method guarantees proper operations (in external
circuit there are additional filtering elements while external adapter guarantees the shortest connections). If you really need to connect
desoldered device in the clip, please do it very carefully. For FLASH SPI you should use as short wires as possible (5cm) and decrease SCK

frequency to 10% (Settings -> Options -> Hardware -> SCK = 10%). It not guarantees success but increases your chances.
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Connecting the CLIP

Connection schema is displayed in application during device selection. In most cases connection is straight ,,1 to 1” as you can see on the left picture
(programmer pin 1 should be connected to memory pin 1, programmer pin 2 to memory pin 2, pin 3 to pin 3 etc.). In some cases connection is not

straight, e.g. for 35080 memory (programmer pin 1 to memory pin 2, programmer pin 2 to memory pin 4 etc. - picture on the right).

|_ = --\--_-_.— ] & |_ |_ _-_-:_ —h.l P =
w3zl i - 1 1 43zl ™ e /!\\
| 2 2 1 D B e 4 1 D B
| v | L 5] | | ) ] 0T ]
SE7H [ 4221 4 I EELA?H 2] SE78 | 4 |80 ] (2] EEPHOM 7 ]
senes series
AT 515 (& | zs.0001pp) [EJ == 57| (O]| om0 [BJ
§ B B . B B
OoCoI0; 7 et 5 | O 5 OO 7| = s T 5]
P@®®®| [s|={g| [FPI-PaePogen DEEOE =18
Straight connection ,,1 to 1” for FLASH SPI Not straight connection for 35080

First of all you should identify PIN 1 in the device®>. Secondly you should connect wires to the clip and then clamp the clip on the device (so
connections will fit to schema). It is recommended to use dedicated ISP 10-pin socket in programmer. Please do not suggest with color of wires in tape

- only pin numbers are important. Example movie with POMONA CLIP connecting for 1-wire device: https://youtu.be/r2T78070xfQ?t=145

5 Pin no. 1 in the device is pointed with small dot in corner or with milled edge (as you can see at picture in schema above)
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5.6. Troubleshooting for in-circuit programming

If you can program device in programmer's socket (or adapter) with success, but you cannot program it in circuit than there are few things that you
can check. First of all, make sure that:

e all wires are connected properly (please take special care for pin contact in case of programming with SOIC CLIP),
e external circuit is powered properly and there is no voltage conflict on power bus,

e SPI lines: CS, (MOSI), (MISO) and (SCK) have pull-up resistors to power supply (4.7k - 10k),

e communication lines do not have additional elements, such as diodes, bus-switches, transistors etc.

e there is no communication conflict on the bus (e.g. processor and all other devices connected to shared SPI bus should be in RESET state).
Secondly, if problem still exist, there are still may be some tricky issues. Few examples with solutions below:

e noise and overshooting (communication errors, random read) - possible solutions:
o decrease SPI clock to 10% for FLASH SPI devices (menu Settings -> Options -> Hardware -> FLASH SPI SCK),
o impedance matching and termination for external circuit (and wires) by using e.g. termination resistors on signal wires. There is no universal

value of resistance (each circuit is different) but in most cases 100 - 1000 Ohm resistors in serial for CS, (MOSI) and (SCK) will be enough:

DEVICE PROGRAMMER
cs cs
Sil—  oRl—— | mos
S0 MISO
scK b— [G70R }——1 sCk
SPI_SLAVE SPI_MASTER

o CS line decoupling (33pF - 220pF to ground as close as possible to the device in-circuit),

o VCC line decoupling (100nF to ground as close as possible to the device in-circuit),
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e to low voltage level during erasing and/or writing (erase error / communication error):

o when external device (in external circuit) is powered from programmer, than there are also other devices powered too (on the same
power line) and due to higher current consumption output voltage may be too low for erase and write operations. In this case it is
recommended to set VPP slightly higher (e.g. +0.3V) or use external power source and set the same VPP level in application.

e bus conflict (random read or communication error during read):

o in some cases after device power up, the main processor is starting communication with slave devices (e.g. with memory you are trying
to read) - in this case it will be conflict on the bus (random read or communication error). All devices connected to the same
communication bus should be forced to be in RESET state. Sometimes it is enough to use external power supply and wait about 2-3
minutes for initial procedure finished and then try to communicate with the memory (when all devices are in idle state and bus is free).
The other tricky way is to use minimum voltage level to communicate with memory and this voltage level may be too low for other
devices so they will stay in RESET state and will not interrupt communication. On the other hand, to low voltage level may be not enough

to success for erase and write operations.

In some cases design of external circuit does not physically allow for in-circuit programming. In this case chip should be unsoldered and programmed in

programmer's socket or adapter.
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6. Custom Script Programming (I2C / SPI / 1-wire bus)

Custom script programming for I12C/SPI/1-wire bus in case of REVELPROG is a some kind of "bus pirate" tool for serial communication. With
REVELPROG-IS Customs Script tool there is possibility to execute any commands in any sequence with precise delays on SPI, I2C or 1-wire
bus. You can write script to execute commands for unclocking device, read and write hidden (or not) registers, change sector protection bits, write OTP

registers and much more.

In practice it is also very useful tool for electronic enginners and embedded programmers, because there is possibility to communicate with any
serial (I2C, SPI and 1-wire) device. External device or module can be also powered from REVELPROG-IS (1.0 - 5.0V with 0.1V threshold). Only few

connection lines are required for communication (4 wires for SPI or 2 wires for I2C + optional 2 wires for external device power supply).

6.1. Script construction

Typical script consists of (1) #SCRIPT HEADER - information about Custom Script Programming (alpha) O X
software version, (2) #HARDWARE SETTINGS - voltage selection (VPP), Scipt Script maker Information
bus selection (I2C/SPI) and communication speed, (3) #OPERATION (1  Mardware seftings

BUS: [SPI v| PP 33 5] sPD: [sow ~

Script

to n). Each script has to have at least one operation defined.

Each #OPERATION consists of (1) 'SW’ operation parameters: number |Z223777 #2222
of bytes to read/write, delay settings, (2) ‘INSTR’ instruction - sequence |goaTeo= 507 0esr
of bytes for single instruction, (3) '‘DATA’ data to write (optional) - gffﬁ?f?};fs's,10'0'100'1000;
sequence of optional bytes for write after single instruction R
Example construction of typical script with header (software version
v.1.6.0), hardware settings (SPI bus, 3.3V voltage, slowest speed) and
single operation with 1-byte 9Fh command is presented on right image:

Import Export Execute
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6.2. Script syntax

e "#" defines sections, e.g. #SCRIPT HEADER; (header), #HARDWARE SETTINGS; (hardware settings), # OPERATION; (for each operation),

. ;" is placed at the end of each command,
e "i"is placed directly after command words, e.g. SCRIPT: (script version), HW: (hardware settings), SW: (software settings - operation
parameters), INSTR: (instruction), DATA: (write data);

e ", " separates parameters for each command (e.g. between "INSTR:" and ";" comma separates instruction bytes)
e "//" precedes comments which are ignored by script executor

Each script should have single #SCRIPT HEADER, single #HARDWARE SETTINGS and at least one #OPERATION (or more).

6.3. Script maker with GUI

Custom Script Programming (alpha) O
Script maker will help you prepare multiple operations with correct syntax. You

Script | Script maker  Information

Software settings for single instruction

need to set few parameters for each operation:
WREN: RDEN: DBO: DA DAW: DAO: BSYO: TOUT:
Op B M4 B p B B0 Eb & 100 2[00 B
e WREN (Write Enable) + number of bytes to write in single operation, T
ingle instruction (1- ytes,
e RDEN (Read Enable) + number of bytes to read in single operation, 00 01 02
e DBO (Delay Before Operation) - optional delay in ms before operation, Wite bytes after instruction {optional 1-256 bytes)
« DAI (Delay After Instruction) - optional delay in ms after instruction, e D R RS BE RS BRHGRE B BN G b5 S0
e DAW (Delay After Write) - optional delay in ms after write,
e DAO (Delay After Operation) - optional delay in ms after operation,
e BSYO (Busy Operation) - maximum time in ms for write end (e.g. e
op! 10N 10 SCnpi

maximum wait time for busy flag in FLASH SPI or for ACK in I12C devices)

e TOUT (Timeout) - maximum PC timeout in ms for operation end (it is recommended to set timeout greater than sum of all other delays).
Please note that:

e Read/Write length are 0 based (0 means 1 byte, 255 means 256 bytes) and with WREN=0/RDEN=0 length parameter is ignored,
e "SW:" and "HW:" byte format is decimal,
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e "INSTR:" and "DATA:" byte format is hexadecimal.

Operation code generated by script maker from above example::

#OPERATION;
sw:0,0,1,3,5,5,10,0,100,1000;
INSTR: 9F;

As you can see SW parameters are equal to script maker parameters:

SW:WREN[O-1],WriteLength[0-255],RDEN[0-1],ReadLength[0-255],DBO[0-250],DAI[0-250],DAW[0-250],DA0O[0-250],BSYO[0-n],TOUT[0-n];

6.4. Script execution sequence

Each script is executed with following sequence:

SET HW (BUS, VPP, SPEED)
EXECUTE OPERATION 1 (SET SW -> DBO -> INSTR -> DAI -> WRITE -> DAW -> BSYO -> READ -> DAO)
EXECUTE OPERATION 2

EXECUTE OPERATION N
RESET HARDWARE*

o uu A W N -

*instead of RESET HARDWARE you can end script with additional command #LEAVEVPPENABLED so power supply will be not disabled after script

execution
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6.5. Additional script syntax

#LeaveVppEnabled
Use this command at the end of each script to left VPP enabled after script execution.

#INSTR and #DATA formatting
It’s allowed to ignore commas and spaces for input data for above fields (e.g. #DATA:0011223344; instead of #DATA: 00, 11, 22, 33, 44;)

#DATA:BUFFER
It will import data bytes directly from application buffer, so you do not have type data bytes in script directly. Address will be incremented in

background, so it will import bytes from buffer with proper offset. You can also define custom offset, e.g. #DATA: BUFFER, 8;

6.6. Pre-script and Post-script

Custom script can be also used as a pre-script or post-script during normal memory operation. Enter CTRL + ALT + SHIFT +S to show script tabs in

memory database. You can also use pre- and post- scripts with Automatic Mode Tool.

6.7. Script examples

Please take a look at forum tutorial for more information and script examples:

https://forum.reveltronics.com/viewtopic.php?f=22&t=280
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7. SFP / QSFP / XFP transceivers

REVELPROG-IS allows programming SFP, QSFP and XFP transceivers. Hardware adapter with SFP/QSFP/XFP connectors and external power supply is
required. MSA Standard is supported (e.g. SFF-8472, SFF-8636, INF-8077i). Special features allows to enter manufacturer / host password and

program write protected transceivers, brute force password (searching password for protected transceivers with unknown password), change
manufacturer info, model, serial number etc. and recalculate checksums directly from REVELPROG-IS application.

7.1. Adapter connection

Please connect external QSFP SFP XFP Adapter for REVELPROG-IS using
10-pin connector. Please connect power supply to adapter. Please insert

transceiver to dedicated transceiver slot. Only one transceiver should be
inserted at the same time.

Example of connected QSFP SFP XFP Adapter (please note that power supply
of adapter is also from PC USB port):
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7.2. Device selection and memory map

Please select transceiver type from memory database (EEPROM -> Transceivers -> SFP or QSFP or XFP).

7.2.1. SFP and SFP+

SFP [AO] and SFP [A2] allows to read/erase/write/verify of AOh and A2h blocks of SFP Transceivers.
These blocks may contain also diagnostic or write protected sectors, so verify may not pass for protected sectors.

SFP [USER] allows read/erase/write of any block or page
in memory map (verification should be done by user). The
[USER] mode allows to read/write specific part of memory.

In block AOh (256bytes) first 128bytes (00h - 7Fh) are for
serial ID and vendor information. It may be write protected
(password may be required). Second 128bytes (80h-FFh)
are reserved.

In block A2h (256bytes) first 127bytes (00h - 7Eh) are
diagnostic information (alarm and warning thresholds, cal
constants, real time diagnostics) and optional password
entry area. 128™ byte (7Fh) is page select byte (only if SFP
supports pages). Next 128 bytes (80h-FFh) is page content
(depends on selected page). SFP may not support A2h block
(it will be communication error) or page select (it may
contain only single page). Page 00h or 01h is User Writable
EEPROM (120bytes) and vendor specific (8bytes). Page 0
may be write protected (password may be required). Page
02h is for control functions. Pages 03h-7Fh are reserved.
Pages 80h-FFh are vendor specific.

2 wire address 1010000x (A0h)

2 wirer address 1010001x (AZh)

Serial ID Defined by
SFP MSA (96 bytes)

55

95

Alarm and Warning
Threshold (56 bytes)

Cal Constants

(40 bytes)

Vendor Specific
(32 bytes)

119

126

Real Time Diagnostic
Interface (24 bytes)

Vendor Specific (7 bytes)

Reserved, SFF-8079
(128 bytes)
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127

128

Page Select Byte (Optional)

.

247
255

/ ‘\t:::—_____‘_-_
/ -H‘-H“'-L_HH‘-“-“—"-—-s
User Writable Control Vendor
EEFPROM (120 bytes) Functions| |Reserved Specific
Vendor Specific (8 bytes)
Page 00h/01h Page 02h Pages Pages
03h-7Fh 80h-FFh




7.2.2. QSFP and QSFP+

QSFP [USER] allows to read/erase/write of any block or page in QSFP/QSFP+ memory map (verification should be done by user). The [USER]

mode allows to read/write specific part of memory.

) o . From To Content No. of Type
QSFP/QSFP+ contains only block AOh (256 bytes) divided into pages (byte bytes
. . 2-Wire Serial Address 1010000x
7Fh in block AOh is page select byte). Pages are 128bytes length. Page 00h Lower Page 00h
is required and provides static module identity and capabilities information 0 2 |ID andStatus 3 Read-Only
. . . . 3 21 Interrupt Flags (Clear on read) 19 Read-Only
(it may be write protected with password). Other pages may be optional. 55 55 T Free Side Device Moniors i) Read-Orly
34 81 Channel Monitors 48 Read-Only
; _ 82 85 Reserved 4 Read-Only
Please che.c.k memory map for your QSFP/QSFP+ or in MSA Standard (SFF o 55 T oo 14 Read/Wiiite
8636 specification). 100 106 | Free Side Interrupt Masks 7 Read/Write
107 110 | Free Side Device Properties 4 Read-Only
. 111 112 | Assigned to PCI Express 2 Read/Write
With REVELPROG-IS you can select page from menu (you do not have to 113 116 | Free Side Device Properties 4 Read-Only
change page bytes manually in buffer) and read/write specific pages: 117 | 118 | Reserved 2 Read/Write
ge page by Y ) / P pag 119 122 | Optional Password Change q Write-Only
123 126 | Optional Password Entry 4 Write-Only
127 127 Page Select Byte 1 Read/Write
B Revelprog 15 (v1.8.2) — O * Upper Page 00h

128 128 | Identifier 1 Read-Only
File | Edit View Tools Settings Help 129 191 | Base ID Fields 63 Read-Only
192 223 Extended ID 32 Read-Only
R @ @PP OxrF i 224 255 | Vendor Specific ID 32 Read-Only

r -t ot i }432 o Page 01h (Optional)

_— QSR USER] == — — x 128 255 [ Reserved (previously for SFF-8079 support) 128 Read-Only
_ e = Page 02h (Optional)

a TS Arest |Page Select (12t v| Fage I [ [ MoDutar 18| 255 | User EEPRON Data 128 Read/Write
T P ; e 5 = Page 03h (Optional)

1 |FINISAR CORP ||FIL41EI¢Z)4N—NE |REV. |a |s/m: !AZlScl'?EICIl’JS-J | pc: |lSll.:-ZI | I 38 175 T Free Side Device Threshads s Read-Orly
00 01 02 03 04 05 06 07 08 09 OR 0B OC 0D OE OF ~ 176 223 | Channel Thresholds 48 Read-Only
oD 00 OC 04 00 00 00 40 40 02 DS 05 &7 00 00 96 ..:....@@.5.g... 224 229 Tx EQ, Rx Output and TC Support 6 Read-Only
00 00 C8 00 46 49 4E 49 53 41 52 20 43 4F 52 50  ..E.FINISAR CORP 230 241 | Channel Controls 12 Read/Write

[y 20 20 20 20 07 00 90 &5 46 54 4AC 34 31 30 51 44 -« -.2FTL410QD 242 251 Channel Monitor Masks 10 Readj{Wl'ite

0 34 4E 2D 4E 53 20 20 20 41 20 42 63 07 DO 55 11 4N-NS5 A Bh.BU. 555 555 | Reserved 7 Read/Wiite

) 00 07 OF DE 41 5R 31 33 34 37 30 30 30 39 30 20 ...BAZ184700090 - _

20 20 20 20 31 38 31 31 32 30 20 20 3C 00 00 A5 191120 <..¥ S Pages 04h-1Fh (Optional) _

q 4E 4F 4B 435 41 50 34 36 30 38 35 36 34 37 34 33 NOoKIRP4s03564743 128 255 [ Vendor Specific _ 128 Read/Write

0 39 39 41 00 00 00 00 00 00 00 00 00 00 00 00 00 998, . ....c.eeun. Pages 20h-21h (Optional)

e 128 255 | PAM-4 and WDM Features 128 Read/Write

Address: o0 Pages 22h-7H (Optional) .

Buffersize:  Ox0 - Ox7F (128 Bytes) W\Work\Projekty\QSFP\QSFP_NOKIA_FINISAR_AD_PageD.bin 128 255 [ Reserved 128 Read/Write

. Pages 80h-Fh (Optional)
Programmer is connected (v1.8.2) 128 255 | Vendor Specific 128 Read/Write
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7.2.3. XFP

e XFP [USER] allows to read/erase/write of any block or table in QSFP/QSFP+ 2-Wire Serial Address
memory map (verification should be done by user). The [USER] mode allows to o.  1010000X (AOH)
read/write specific part of memory. Digital

Diagnostic

Functions

XFP contains only block AOh (256 bytes) divided into tables (byte 7Fh in block

118

AOh is table select byte). Tables are 128bytes length. Table 01h is default and 119-122 | 4 Byte Password Change
contains Serial ID Data. Table 02h is User EEPROM. Tables may be write 126 | 4 Byte Password Entry
protected (password may be required for erase or write). Other pages may be 1oy | "208 SelectByte Entry
optional.
Please check memory map for your XFP or in MSA Standard (INF-8077i | __ P 128
specification).

Reserved XFP MSA User Vendor

for Future Serial 1D EEPROM Specific Reserved
With REVELPROG-IS you can select table from menu (you do not have to Eiagn_osﬂc Data Data Functions

unctions 223
change page bytes manually in buffer) and read/write specific tables. 224- Vendor Specific

255 255 I Data 255 255 255
Table 00h Table 01h Table 02h Table 03h-7Fh Table 80h-FFh

7.3. Protected transceivers: manufacturer password and host password

Some transceivers also provides an optional password entry location that may be used to protect vendor internal function or user writable memory.
Password shall not be required to read any data, but it may be used for write protection for specific areas. Nor shall passwords be required to write any
controls defined in the digital diagnostics functions. Passwords may be used by vendors to control write access to MSA defined read only data for
factory setup, or to OEMs to limit write access in the User EEPROM area. Finally, passwords may be used to control read or write access to the vendor
specific pages or tables. Separate passwords value ranges will be defined to prevent accidental writing to critical module control areas. There are 2
types of passwords: manufacturer password and host password (also known as user password). You can enter password using password tool in
REVEPLROG-IS application.
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7.3.1. Host/User password

Host password is protecting User Writable EEPROM. Entering valid user password will unlock only user eeprom for erase and write operations.

Location of this area depends on transceiver type (please check memory map for your transceiver). In most cases user can change this password (if

current password is known). All factory new transceivers should have default host password: 00h 00h 10h 11h.

7.3.2. Manufacturer password

Manufacturer password is protecting whole memory map, e.g. serial number, product name,
manufacturer name, vendor specific areas etc. Entering valid manufacturer password will unlock all
memory map for erase and write operations. Only manufacturer know this password, but

REVELPROG-IS provides tool for searching password with brute force method.

7.3.3. Hacking password (brute-force method)

REVELPROG-IS password tool for transceivers can be also used to search password using brute
force method (checking all combinations or limited range of combinations). It uses smart algorithm
with auto-adjusting communication speed and delays to check as many password as possible in
shortest time. For fastest MCU based transceivers it's possible to check 4000 password combinations

per second. Please check more details and on REVELTRONICS forum:

https://forum.reveltronics.com/viewtopic.php?f=31&t=527
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Password tool for SFP/OSFP/XFP Transceivers >

Password

[] Enter cument password

Search Password (brute force)

Location: |A21-|,?Bh (5FF) - |

Access type: | Huost/ser (user eepram) e |

Range limit: |ASCII letters, number and special chare - |

Write delay: |L|ser select V |
0 & [ms] e
Start from: 20 20 20 20
START STOP

Searching SFP hostfuser password._.
checked 152500 from 81450625 (4013/s)
20h 30h 75h 38h ASCI: Oug

00d00h00m38s 00d05h37m38s



https://forum.reveltronics.com/viewtopic.php?f=31&t=527

8. Updates

New trends on the market and latest devices require from users newer and newer programming devices. Customer's satisfaction is our number one
priority and we share updates free of charge for all users of REVELPROG-IS. Update consist of software update (pc application) and firmware update
(software inside the device). Latest software can be downloaded directly from manufacturer’'s webpage. You will be informed by the software about

possible updates after connecting out of date device.

Caution! If a firmware update process is interrupted, your programmer may not function properly. Updates are optional — warranty does not cover

damage due improper care.

During update process, device will start in DFU (Device Firmware Upgrade) mode. First time it may be necessary to install additional drivers (for DFU
mode). Windows should find drivers automatically on the Internet (if not, there are also available in /drivers/DFU subdirectory in the installation folder).
Installing drivers process should take about 30 seconds. If DFU drivers are installed, application will update the firmware device. Appropriate

instructions will be displayed before.

Warnings - read carefully! &[

Please close all other applications and disable antivirus software during update

process. Do not disconnect and do not connect any USB devices during update
process. Make sure that you have stable power supply for PC. i Btentico
1) do not disconnect power supply from computer,

Update process may take about half a minute. Progress will be displayed on the l 2) do not disconnect the device from PC,

. A . 3) it is recommended to close all other applications.
screen. There is no possibility to cancel this process! After successful update,

Do NOT interrupt this process,

device will restart and will be ready to use.
y Interrupting this process could render your device NOT functional.

Continue?

[ Tk | Nie [ Anulyj
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9. Research and development

We are keen to still develop and improve the device. Please contact us at lab@reveltronics.com or visit our contact page at www.reveltronics.com if

you have any comments or tips about REVELPROG-IS.

Very welcome are ideas:

e how to improve REVELPROG-IS - what functionality add to it,
e what chips add to supported device list in the next update (please suggest only serial I12C, SPI, uWire devices).

Repeated suggestions from many users will have more chance for implementation in the future. We encourage you to contact us because in this way

we already added many devices popular only in small segments of automotive market, computer service, RTV/AGD devices etc.
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10.

APPENDIX A - List of supported devices

The following list details the family of supported devices (left column) with selected examples of supported memories (right column). Most chips

have the same programming procedures - programmer supports more devices than the examples given in the list.

EEPROM I2C 24... series

24.01
(1kb)

24..02
(2kb)

24..04
(4kb)

24AA01 | 24AA014 | 24AA014H | 24AA0TH | 24C01 | 24C01A | 24C01B | 24C01C | 24LCO01 | 24LC014 | 24LCO14H | 24LCO1B | 24LCO1BH | AF24BCO01 |
AT24C01 | AT24C01A | AT24C01B | BR24A01AF | BR24A0TAFJ | BR24C01 | BR24CO1A | BR24CO1AF | BR24CO1AFJ | BR24CO1AFV | BR24C21F |
BR24C21FJ | BR24C21FV | BR24G01 | BR24GO1F | BR24GO1FJ | BR24GOTFV | BR24GO1FVT | BR24L01 | BR24L0O1A | BR24LOTAF | BR24LOTAFJ |
BR24L0OTAFV | BR24LOTAFVM | BR24LOTAFVT | BR24TO1A | CAT24AA01 | CAT24C01 | CAT24C01B | CAT24C21 | CAT24FCO1 | CAT24LCO1 |
CAT24WCO1 | CR24C01 | CY24C01 | FM24C01 | FT24C01 | FT24C0O1A | GE24C01 | GP24BCO1 | HM24LCO1 | HT24C01 | HT24LCO1 | IS24C01 |
[S24C01B | LT24CO01 | LX24CO01 | M24C01 | MM24C01 | S-24C01A | S-24C01B | S-24C01C | S-24CSO1A | SLA24CO01 | SLE24C01 | ST24C01 | ST24WO0T1 |
TMC24A01 | TU24C01B | UG24CO01 | X24012 | X24C01 | X24CO1A | XL24CO1A

24AA02 | 24AA024 | 24AA024H | 24AA025 | 24AA02H | 24C02 | 24C02A | 24C02B | 24C02C | 24LCO02 | 24L.C024 | 24LC024H | 24L.C025 | 24LCO2B |
24L.C02BH | 24LCO2W | 24LLCO2 | A24C02 | ACE24C02 | ACE24LCO02 | AF24BC02 | AM24LC02 | AT24C02 | AT24C02A | AT24C02B | AT24C02C |
AT24HCO02B | AT24HCO04B | AX24C02A | BJX25LCO02 | BL24C02 | BR24A02F | BR24A02FJ | BR24A02FVM | BR24C02 | BR24C02F | BR24CO2FV |
BR24G02F | BR24G02FJ | BR24GO2FVT | BR24L02 | BR24L02F | BR24L02FJ | BR24L0O2FV | BR24L02FVM | BR24L02FVT | BR24T02 | CAT24AA02 |
CAT24C02 | CAT24C03 | CAT24LC02 | CAT24LCO2A | CAT24LC02AZ | CAT24LC02Z | CAT24WCO02 | CAT24WCO03 | CKD24A02 | CR24C02 | CW24C02 |
CW24C02B | CY24C02 | EC24C02 | EC24C02A | EM24LCO02 | FM24C02 | FM24C02U | FM24C02UF | FM24C03U | FM24CO03UF | FT24C02 | FT24C02A |
GE24C02 | GM24LC02B | GP24BC02 | HM24LC02 | HN58X2402 | HT24C02 | HT24LCO02 | IN24AA02A | IN24AA02B | IN24LC02B | 1S24C02 | IS24C02A |
IS24C02B | IS24C02E | K24C02 | KK24LCO02B | L24C02 | L24W02 | LE24C0221 | LE24C023 | LE24L0221 | LT24C02 | LX24C02 | LY24C02 | M24CO02 |
MAX24A02 | MC24C02 | MC24LC02 | MM24C02 | NM24C02 | NM24CO02F | NM24C02U | NM24C03 | NM24C03F | NM24W02 | NSC24C02 | PCF8582C-2
| PTK24A02T | RT24A02 | S-24C02A | S-24C02B | S-24C02C | S-24CS02A | SLA24C02 | SLE24C02 | SM24C02 | ST24C02 | ST24W02 | T24C02 |
T24C02A | TMC24A02 | TU24C02B | UG24C02 | WS24C02 | X24022 | X24C02 | XL24C02 | Y24LC02

24AA04 | 24AA04H | 24C04 | 24C04A | 24LC04 | 24LC04B | 24LC04BH | A24C04 | ACE24C04 | ACE24LC02 | AF24BC04 | AM24LC04 | AT24C04 |
AT24C04A | AT24C04B | AX24C04A | BUX24LC04 | BL24C04 | BR24A04F | BR24A04FJ | BR24C04 | BR24C04F | BR24C04FJ | BR24C04FV | BR24GOA4F |
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24..08
(8kb)

24.16
(16kb)

BR24G04FJ | BR24G04FV | BR24GO4FVT | BR24L04 | BR24L04F | BR24L04FJ | BR24L04FV | BR24L04FVM | BR24L04FVT | BR24T04 | CAT24C04 |
CAT24C05 | CAT24LC04 | CAT24WCO04 | CAT24WCO05 | CR24C04 | CW24C04 | CW24C04A | CY24C04 | EC24C04 | EC24C04A | FM24C04 | FM24C04U |
FM24C04UF | FM24C05U | FM24C0O5UF | FM24CL04 | FT24C04 | FT24C04A | GE24C04 | GM24LC04B | HM24LC04 | HN58X2404 | HT24C04 |
HT24LC04 | IN24LC04B | IS24C04 | IS24C04A | 1IS24C04B | K24C04 | KK24LCO04 | KK24LCO04B | L24C04 | L24W04 | LE24C042 | LE24C043 | LT24C04 |
LX24C04 | LY24C04 | M24C04 | M24LC04 | MM24C04 | NM24C04 | NM24C04F | NM24C04U | NM24CO05 | NM24CO5F | NM24W04 | S-24C04A | S-
24C04B | S-24CS04A | SLA24C04 | SLE24C04 | ST24C04 | ST24W04 | T24C04 | T24C04A | TMC24A04 | TU24C04B | UG24C04 | WS24W04 | X24042 |
X24C04 | XL24C04 | Y24LC04

24AA08 | 24AA08H | 24C08 | 24C08B | 24LC08 | 24LC0O8B | 24LCO8BH | 24LLCO8 | A24C08 | ACE24C08 | ACE24C0O8A | ACE24L.C08 | ACE24LCO8A |
AF24BC08 | AM24LCO08 | AT24C08 | AT24C08A | AT24C08B | AT24RF08C | AX24C08A | BL24C08 | BR24A08F | BR24A08FJ | BR24C08 | BR24CO8F |
BR24C08FJ | BR24C08FV | BR24G08F | BR24G08FJ | BR24G0O8FV | BR24G08FVT | BR24L08 | BR24L0O8F | BR24L08FJ | BR24LO8FV | BR24L08FVM |
BR24L0O8FVT | BR24T08 | CAT24C08 | CAT24LCO08 | CAT24WCO08 | CR24C08 | CW24C08 | CW24C08B | CY24C08 | EC24C08 | EC24C08A | FM24C08 |
FM24C08U | FM24C08UF | FM24C09UF | FM24CL08 | FT24C08 | FT24C08A | GM24LC08B | GP24BC08 | HN58X2408 | HT24C08 | HT24LCO08 |
IN24AA08B | IN24LCO8B | IS24C08 | IS24C08A | K24C08 | KK24LC08 | KK24LCO08B | L24M08 | L24W08 | LE24C081 | LE24C082 | LE24L082 | LT24CO08 |
LX24C08 | LY24C08 | M24C08 | MAX24A08 | MC24C08 | MC24LC08 | MM24C08 | MTV24C08 | MTV24LC08 | NM24C08 | NM24CO8F | NM24C08U |
NM24C09 | NM24C0O9F | NM24C09U | NM24W08 | NSC24C08 | P24S08 | PCA24S08 | PS08 | PTK24A08T | S-24C08A | S-24C08C | S-24CS08A |
SLA24C08 | SLE24C08 | ST24C08 | ST24W08 | T24C08 | T24C08A | TMC24A08 | TU24C08B | UG24C08 | WS24W08 | X24C08 | XL24C08 | Y24LCO08
24AA16 | 24AA1T6H | 24C16 | 24C16B | 24LC16 | 24LC164 | 24LC16B | 24LC16BH | 24LLC16 | 24U17 | A24C16 | ACE24C16 | ACE24LC16 | AF24BC16 |
AM24LC16 | AT24C16 | AT24C164 | AT24C16A | AT24C16B | AT24C16C | AX24C16A | BJX24LC16 | BL24C16 | BR24A16F | BR24A16FJ | BR24C16 |
BR24C16F | BR24C16FJ | BR24C16FV | BR24E16 | BR24E16F | BR24E16FJ | BR24E16FV | BR24G16F | BR24G16FJ | BR24G16FV | BR24G16FVT |
BR24L16 | BR24L16F | BR24L16FJ | BR24L16FV | BR24L16FVT | BR24S16F | BR24S16FJ | BR24S16FV | BR24S16FVM | BR24S16FVT | BR24T16 |
CAT24C16 | CAT24C16L | CAT24C16Z | CAT24FC16 | CAT24FC17 | CAT24WC16 | CAT24WC17 | CR24C16 | CW24C16 | CW24C16A | CY24C16 |
EC24C16 | EC24C16A | FM24C16 | FM24C16U | FM24C16UF | FM24C17 | FM24C17U | FM24C17UF | FM24CL16 | FT24C16 | FT24C16A | GM24LC16B |
GP24BC16 | HM24LC16 | HN58X2416 | HT24C16 | HT24LC16 | IN24LC16B | 1IS24C16 | IS24C16A | KK24LC16 | KK24LC16B | L24W16 | LE24C162 |
LE24L162 | LT24C16 | LX24C16 | LY24C16 | M24C16 | MAX24A16 | MC24C16 | MC24LC16 | MM24C16 | MTV24C16 | MTV24LC16 | NM24C16 |
NM24C16F | NM24C16U | NM24C17 | NM24C17F | NM24C17U | NM24W16 | NSC24C16 | PTK24A16T | S-24C16A | S-24CS16A | SLA24C16 | SLE24C16
| SLE24C164 | ST24C16 | ST24W16 | T24C16 | T24C16A | TMC24A16 | TU24C16B | UG24C16 | WS24W16 | X24164 | X24165 | X24C16 | XL24C16 |
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24..32
(32kb)

24..64
(64kb)

24.128
(128kb)

24..256
(256kb)

24..512
(512kb)

XL24C164 | Y24LC16

24AA32 | 24AA32A | 24C32 | 24LC32 | 24LC32A | 24LC32B | A24C32 | ACE24C32 | ACE24C32A | AF24BC32 | AT24C32 | AT24C32A | AT24C32B |
AT24C32C | AT24C32D | AX24C32A | BR24A32F | BR24A32FJ | BR24C32 | BR24C32F | BR24G32F | BR24G32FJ | BR24G32FV | BR24G32FVT | BR24L32
| BR24L32F | BR24L32FJ | BR24L32FV | BR24L32FVT | BR24S32F | BR24S32FJ | BR24S32FV | BR24S32FVM | BR24S32FVT | BR24T32 | CAT24C32 |
CAT24FC32 | CAT24FC32A | CAT24WC32 | CAT24WC33 | CR24C32 | CW24C32 | EC24C32 | EC24C32A | FM24C32 | FM24C32U | FM24C32UF |
FT24C32 | FT24C32A | HM24LC32 | HN58X2432 | HT24C32 | HT24LC32 | IN24AA32A | 1IS24C32 | IS24C32A | 1S24C32B | IS24C32C | K24C32 | L24W32
| LE24C322 | LE24L322 | M24C32 | MC24C32 | MM24C32 | NM24C32 | NM24C32U | NM24C32UF | NSC24C32 | PTK24A32T | S-24C32C | SLA24C32 |
SLE24C32 | ST24C32 | T24C32 | T24C32A | TU24C32 | WS24W32 | X24320

24AA64 | 24AA64F | 24AA65 | 24C64 | 24C65 | 24FC64 | 24LC64 | 24LC64B | 24LC64F | 24LC65 | A24C64 | ACE24C64 | ACE24C64A | AF24BC64 |
AT24C64 | AT24C64A | AT24C64B | AT24C64C | AT24C64D | AX24C64A | BR24A64F | BR24A64FJ | BR24C64 | BR24C64F | BR24G64F | BR24G64FJ |
BR24G64FV | BR24G64FVT | BR24L64 | BR24L64F | BR24L64FJ | BR24S64F | BR24S64FJ | BR24S64FV | BR24S64FVM | BR24S64FVT | BR24T64 |
CAT24C64 | CAT24FC64 | CAT24FC65 | CAT24FC66 | CAT24WC64 | CAT24WC65 | CR24C64 | CW24C64 | EC24C64 | EC24C64A | FM24C64 |
FM24C64F | FM24CL64 | FT24C64 | FT24C64A | HM24LC64 | HN58X2464 | HT24C64 | HT24LC64 | IS24C64 | IS24C64A | 1S24C64B | K24C64 | L24W64
| LE24CB642 | M24C64 | MM24C64 | NM24C65 | NM24C65F | NSC24C64 | PTK24A64T | S-24C64C | SLA24C64 | SLE24C64 | ST24C64 | T24C64 |
T24C64A | TU24C64B | WS24W64 | X24640 | X24641 | X24645

24AA128 | 24C128 | 24FC128 | 24LC128 | 24LC21 | 24LC21A | 24LCS21A | ACE24C128 | AF24BC128 | AT24C128 | AT24C128B | AT24C128C |
AT24CS128 | AX24C128A | BL24C128 | BR24G128F | BR24G128FJ | BR24G128FV | BR24G128FVT | BR24S128F | BR24S128FJ | BR24S128FV |
BR24S128FVT | BR24T128 | CAT24C128 | CAT24WC128 | CAT24WC129 | CR24C128 | CW24C128 | EC24C128 | EC24C128A | FM24C128 | FM24C128F
| FM24CL128 | FT24C128 | FT24C128A | HN58X24128 | HT24C128 | HT24LC128 | 1S24C128 | IS24C128A | IS24C128B | 1S24L128 | LE24CB1283 |
M24128 | S-24C128C | T24C128 | T24C128A | TU24C128

24AA256 | 24C256 | 24FC256 | 24LC256 | A24C256 | ACE24C256 | AT24C256 | AT24C256B | AT24C256C | AT24CS256 | AX24C256A | BL24C256 |
BR24S256F | BR24S256FJ | BR24T256 | CAT24C256 | CAT24FC256 | CAT24WC256 | CAT24WC257 | CW24C256 | EC24C256A | FM24C256 |
FM24C256F | FM24CL256 | FT24C256 | FT24C256A | HN58X24256 | HT24C256 | HT24LC256 | 1S24C256 | 1IS24C256A | IS24L256 | M24256 |
MC24C256 | T24C256 | T24C256A | TU24C256

24AA512 | 24C512 | 24FC512 | 24LC512 | 24LC515 | AT24C512 | AT24C512B | AT24C512C | CAT24C512 | CAT24WC512 | FM24C512 | FM24CL512 |
FT24C512A | HN58X24512 | HT24C512 | HT24LC512 | IS24C512 | M24512 | SA24C512
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24.1024 24AA1024 | 24AA1025 | 24AA1026 | 24C1024 | 24C1025 | 24C1026 | 24FC1024 | 24LC1024 | 24LC1025 | 24LC1026 | AT24C1024 | AT24C10248B |

(1Mb) CAT24C1024 | CAT24WC1024 | FM24C1024 | FM24CL1024 | HT24C1024 | HT24LC1024 | 1S24C1024 | M24MO01
24..2048

M24M02
(2Mb)

EEPROM SPI 25... series

25..010 25010 | 25AA010 | 25AA010A | 25C010 | 25LC010 | 25LC0OT0A | A25010A | AT25010 | BR25H010-W | BR25L010-W | CAT25C01 | CAT25C11 | CY25C01 |

(1kb) IS25C01 | S-25A010A | ST25C01 | ST25W01 | XC25010

25..020 25020 | 25AA020 | 25AA020A | 25C020 | 25LC020 | 25LC020A | AT25020 | AT25020A | BR25H020-W | BR25L020-W | CAT25C02 | CAT25C03 |

(2kb) CY25C02 | FM25C020U | FM25C020UL | 1S25C02 | NM25C020 | S-25A020A | ST25C02 | ST25W02 | X25020 | XC25020

25 040 25040 | 25AA040 | 25AA040A | 25C040 | 25C040A | 25L.C040 | 25LC040A | AT25040 | AT25040ACAT25C04 | BR25H040-W | BR25L040-W | CAT25C05 |

k) CY25C04 | FM25C040U | FM25C040UL | FM25C041U | FM25L04 | IN25AA040 | 1IS25C04 | NM24C040 | NM24C041 | S-25A040A | ST25C04 | ST25W04 |
X25040 | X25041 | XC25040

25..080 25080 | 25AA080 | 25AA080A | 25AA080B | 25C080 | 25L.C080 | 25LCO80A | 25L.C080B | AT25080 | AT25080A | AT25080B | BR25H080-W | BR25L080-

(8kb) W | CAT25C08 | CAT25C09 | CY25C08 | FM25L08 | IN25AA080 | 1IS25C08 | S-25A080A | ST25C08 | ST25W08 | X25080 | X25F008 | XC25080

)5 160 25160 | 25AA160 | 25AAT60A | 25AA160B | 25C160 | 25LC160 | 25LCT160A | 25LC160B | AT25160 | AT25160A | AT25160B | BR25H160-W | BR25L160-

(16K W | CAT25C16 | CAT25C17 | CY25C16 | FM25C160 | FM25C160U | FM25C160UL | FM25L016 | IN25AA160 | 1S25C16 | NM24C160 | S-25A160A |
ST25C16 | ST25W16 | X25160 | X25170 | X25F016 | XC25160

25..320 25320 | 25AA320 | 25AA320A | 25C320 | 25LC320 | 25LC320A | AT25320 | AT25320A | AT25320B | BR25H320-W | BR25L320-W | CAT25C32 |

(32kb) CAT25C33 | FM25C320U | FM25C320UL | 1S25C32 | IS25C32A | 1IS25C32B | S-25A320A | TI2532 | X25320 | X25F032 | XC25320

25..640 25640 | 25AA640 | 25C640 | 25LC640 | AT25640 | AT25640A | AT25640B | BR25L640-W | CAT25C64 | CAT25C65 | FM25C640U | FM25CL64 | FM25L64

(64kb) 11S25C64 | IS25C64A | 1S25C64B | NM24C640 | S-25A640A | TI2564 | X25640 | X25642 | X25650 | X25F064 | XC25640

25..128 25128 | 25AA128 | 25C128 | 25LC128 | AT25128 | AT25128A | CAT25C128 | 1S25C128 | IS25C128A | S-25C128A | X25128 | X25138 | X25F128 |

(128Kkb) XC25128

25..256

256kb) 25256 | 25AA256 | 25C256 | 25L.C256 | AT25256 | AT25256A | CAT25C256 | FM25L.256 | 1S25C256 | IS25C256A | X25256 | XC25256
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25..512
25512 | 25AA512 | 25C512 | 25LC512 | AT25512 | XC25512

(512kb)
25..1024
(M) 251024 | 25AA1024 | 25C1024 | 25L.C1024 | AT251024 | XC251024
25..04
25CSM04
(4Mb)

EEPROM SPI 35... series
D80DOWQ | D8ODOWQ | M35080 | M35080-3 | M35080-6 | M35080V6 | M35080-VP
(write incremental register with higher value, erase and write remaining buffer)
35128WT | D128DOWQ | D128DOWT | D128DOWQ | D128DOWT | M35128
(write incremental register with higher value, erase and write remaining buffer)
D160DOWQ | D160DOWT | D160DOWQ | D160DOWT | M35160

(write incremental register with higher value, erase and write remaining buffer)

35..080 (8kb)

35..128 (16kb)

35..160 (16kb)

EEPROM SPI 95... series
(1kb - 2Mb) ' M95010 | M95020 | M95040 | 5P08 | 5P08C3 | M95080 | M95160 | M95320 | M95640 | M95128 | M95256 | M95512 | M95MO01 | M95MO02

EEPROM MICROWIRE 93... series

Compatible both addressing modes (8- and 16-bit)

93..06

(256b) 9306 | 93C06 | KM93C06 | KM93C06GD | M93C06 | NMC9306 | NMC93C06L | NMC93C06LZ

93..46 93AA46 | 93AA46A | 93AA46B | 93AA46C | 93C46 | 93C46A | 93C46B | 93C46C | 93CX46 | 93LC4A6 | 93LC46A | 93LC46B | 93LC46C | 93S46 | 93X46 |
a kb) A93C46 | AF93BC46 | AK93C46 | AM93LC46 | AT93C46 | AT93C46A | AT93C46B | AT93C46C | AT93C46D | AT93C46E | BL93C46 | BR93A46 | BRO3C46 |

BRO3H76 | BR93L46 | BRO3LC46 | CAT93C46 | CAT93C46A | CAT93C46AH | CAT93C46B | CAT93C46H | CAT93C46R | CAT93HC46 | CR93C46 |
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93..56
(2kb)

93..66

(4kb)

93..76
(8kb)

EC93C46A | EM93LC46 | FM93C46 | FM93C46A | FT93C46 | FT93C46A | GSCI3BC46A | GT93C46 | GT93C46A | HTO3LC46-A | IN93AA46A | IN93AA46B |
IN93AA46C | IN93LCA6A | IN93LC46B | IN93LC46C | IS93C46-3 | IS93C46A | IS93C46AGR | 1S93C46B | IS93C46BGR | IS93C46D | IS93C46DGR | K93C46 |
KM93C46 | KM93C46GD | KM93C46V | KM93C46VGD | LC46 | M93C46 | M93S46 | MAX93LC46 | MC93C46 | MM93C46-3 | MM93C46-3GR | NM93C46 |
NM93C46A | NM93C46L | NM93C46LZ | NM93CS46 | NMC9346 | PTK93LC46 | RH76 | RT93LC46 | S93462 | S93463 | S93A46 | S-93A46A | S-93A468B | S-
93L46AD | S93VP462 | S93VP463 | S93WD462 | SO93WD463 | T93C46 | T93C46A | TMCO3LC46 | TU93C46 | UG93C46-A | WO3C46 | W93C46B | XL93C46 |
XL93LC46 | XL93LC46A | XL93LC46ARY | XL93LC46B | XL93LC46BRY | XL93LC46RY | YO3LC46

93AA56 | 93AAS56A | 93AA56B | 93AA56C | 93C56 | 93C56A | 93C56B | 93C56C | 93CX56 | 93LCS56 | 93LCS56A | 93LC56B | 93LCS56C | 93S56 | 93X56 |
A93C56 | AF93BC56 | AK93C56 | AM93LCS56 | AT93C56 | AT93C56A | AT93C56B | AT93C56C | AT93C56D | AT93CS56E | AT93C57 | BL93C56 | BRO3AS56 |
BR93C56 | BR93L56 | BRO3LC56 | CAT93C56 | CAT93C56A | CAT93C56AH | CAT93C56B | CAT93C56H | CAT93C56R | CAT93C57 | CAT93HCS6 |
CR93C56 | EC93C56A | EM93LCS56 | EM93LC57 | FM93C56 | FM93C56A | FT93C56 | FT93C56A | GSC93BC56A | GT93C56 | GT93C56A | HT93LCS6-A |
INO3AAS6A | IN93AAS56B | IN93AAS6C | IN93LCS56A | IN93LCS56B | IN93LC56C | IS93C56-3 | IS93C56A | IS93C56AGR | IS93C56B | IS93C56BGR |
IS93C56D | IS93C56DGR | K93C56 | KM93C56 | KM93C56GD | KM93C56V | KM93C56VGD | KM93C57 | KM93C57GD | KM93C57V | M93C56 | M93S56 |
MC93C56 | MM93C56-3 | MM93C56-3GR | NM93C56 | NM93C56A | NM93C56L | NM93C56LZ | NM93CS56 | PTK93LC56 | S93A56 | S-93A56A | S-
93A56B | S-93L56AD | ST93CS56 | ST93CSS57 | T93C56 | T93C56A | TMCIO3LCS6 | TMCIO3LCS7 | TU93CS6 | UG93C56-A | UG93C56-C | WI3C56 |
WO93C56B | XL93C56 | XL93LC56 | XL93LCS6A | XLI93LC56ARY | XL93LCS56B | XL93LCS56BRY | XL93LCS56RY | YO3LCS56-A

93AA66 | 93AA66A | 93AA66B | 93AA66C | 93C66 | 93C66A | 93C66B | 93C66C | 93CX66 | 93LC66 | 93LCOH6A | 93LC66B | 93LC66C | 93S66 | 93X66 |
A93C66 | AF93BC66 | AK93C66 | AMI3LC6E6 | AT93C66 | ATO3C66A | AT93C66B | AT93C66C | AT93C66D | AT93C66E | BL93C66 | BRI3A66 | BRO3C66 |
BRIO3L66 | BR93LC66 | CAT93C66 | CAT93C66A | CAT93C66AH | CAT93C66B | CAT93C66H | CAT93C66R | CAT93HC6E6 | CR93C66 | EC93C66A |
EM93LC66 | FM93C66 | FM93C66A | FT93C66 | FT93C66A | GSCI93BC66A | GT93C66 | GTI93C66A | HT93LC66-A | IN93AAG6A | IN93AAG6B | IN93AAG6C
| IN93LC66A | IN93LC66B | IN93LC66C | IS93C66-3 | IS93C66A | ISO3C66AGR | IS93C66B | IS93C66BGR | IS93C66D | IS93C66DGR | K93C66 | KM93C66 |
KM93C66GD | KM93C66V | KM93C66VGD | KM93C67 | KM93C67GD | KM93C67V | M93C66 | M93S66 | MC93C66 | MM93C66-3 | MM93C66-3GR |
NM93C66 | NM93C66A | NM93C66L | NM93C66LZ | NM93CS66 | PTKO3LC66 | S93662 | S93663 | S93A66 | S93A66A | S-93A66A | S-93A66B | S-93L66AD
| S93VP662 | S93VP663 | S93WD662 | S93WD663 | T93C66 | T93C66A | TMCI3LC66 | TU93C66 | UGI3C66-A | WI3C66 | WI3C66B | XLI93C66 |
XL93LC66 | XL93LCH66A | XL93LCE6ARY | XL93LC66B | XL93LC66BRY | XL93LC66RY | YO3LC66-A

93AA76 | 93AA76A | 93AA76B | 93AA76C | 93C76 | 93C76A | 93C76B | 93C76C | 93CX76 | 93LC76 | 93LC76A | 93LC76B | 93LC76C | 93X76 | A93C76 |
AF93BC76 | AK93C76 | AM93LC76 | AT93C76 | AT93C76A | AT93C76B | AT93C76C | AT93C76D | AT93C76E | BL93C76 | BR93A76 | BR93C76 | BRO3L76 |
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93..86
(16kb)

BRO3LC76 | CAT93C76 | CAT93C76A | CAT93C76AH | CAT93C76B | CAT93C76H | CAT93C76R | CAT93HC76 | CR93C76 | EC93C76A | EM93LC76 |
FM93C76 | FM93C76A | FT93C76 | FT93C76A | GSC93BC76A | GT93C76 | GT93C76A | HT93LC76-A | IN93AAT76A | IN93AA76B | IN93AA76C | IN93LC76A
| IN93LC76B | IN93LC76C | IS93C76-3 | IS93C76A | IS93C76AGR | IS93C76B | IS93C76BGR | IS93C76D | IS93C76DGR | K93C76 | KM93C76 | KM93C76GD
| KM93C76V | KM93C76VGD | M93C76 | MC93C76 | MM93C76-3 | MM93C76-3GR | NM93C76 | NM93C76A | NM93C76L | NM93C76LZ | PTK93LC76 | S-
93A76A | S-93A76B | S-93L76AD | T93C76 | T93C76A | TMC93LC76 | W93C76 | W93C76B | XL93C76 | XL93LC76 | XL93LC76A | XL93LC76ARY |
XL93LC76B | XL93LC76BRY | XL93LC76RY

93AA86 | 93AA8B6A | 93AA86B | 93AA86C | 93C86 | 93C86A | 93C86B | 93C86C | 93CX86 | 93LC86 | 93LCB6A | 93LC86B | 93LC86C | 93X86 | A93C86 |
AF93BC86 | AK93C86 | AM9O3LC86 | AT93C86 | AT93C86A | AT93C86B | AT93C86C | AT93C86D | AT93C86E | BL93C86 | BRO3A86 | BR93C86 | BRO3L86 |
BRO3LC86 | CAT93C86 | CAT93C86A | CAT93C86AH | CAT93C86B | CAT93C86H | CAT93C86R | CAT93HC86 | CR93C86 | ECO93C86A | EM93LC86 |
FM93C86 | FM93C86A | FT93C86 | FT93C86A | GSCI93BC86A | GT93C86 | GT93C86A | HT93LC86-A | IN93AAB6A | IN93AA86B | IN93AA86C | IN93LC86A
| IN93LC86B | IN93LC86C | 1IS93C86-3 | IS93C86A | IS93C86AGR | IS93C86B | IS93C86BGR | 1S93C86D | IS93C86DGR | K93C86 | KM93C86 | KM93C86GD
| KM93C86V | KM93C86VGD | M93C86 | MC93C86 | MM93C86-3 | MM93C86-3GR | NM93C86 | NM93C86A | NM93C86L | NM93C86LZ | PTK93LC86 |
S93A86 | S93A86A | S-93A86A | S-93A86B | S-93L86AD | T93C86 | T93C86A | TMCI93LC86 | WIO3C86 | WO3C86B | XL93C86 | XL93LC86 | XL93LC86A |
XL93LC86ARY | XL93LC86B | XL93LC86BRY | XL93LC86RY

EEPROM SPI 90... series

(1kb - 4kb) ' BR9010 | BR9020 | BR9040

EEPROM 1-Wire devices

Supports 1-wire devices and battery chips

MAX...

DS2430A | DS2431 | MAX31826 | DS2433 | DS24B33 | DS28EC20 | DS2434 | DS2436
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FLASH SPI 25... series

Supports low-voltage serial flash memories (1.2V, 1.8V, 2.5V) and standard (3.3V)

25..05
(512kb)

25..010
(TMb)

25..020
(2Mb)

25..040
(4Mb)

A25L05P | A25L512 | A25L512A | A25LS512A | AC25LV512 | AT25DL5121 | AT25DNS12C | AT25F512 | AT26DF5121 | EN25B05 | EN25F05 | EN25PO05 |
F25D512Q | F25L0512 | F25L0SP | F25L05PA | F25L512P | F25L512Q | GD25D05C | GD25Q05 | GD25WDO05C | KH25L512 | M25P05 | M25P05-A |
MS25X512 | MX25L512 | MX25L5121 | MX25L5121E | MX25L512C | MX25L512E | MX25R512F | MX25U5121E | MX25V512 | MX25V5121E |
MX25V512C | MX25V512E | MX25V512F | PM25LD512 | PM25LV512 | PM25LV512A | SA25F005 | SST25VF512 | SST25VF512A | SST25WF512 |
SST25WF512B | W25Q05CL | W25Q05CV | W25X05CL

A25L010 | A25L010A | A25L10P | AC25LV010 | AT24F1024 | AT25DNO11 | AT25FS010 | EN24LF10 | EN25B10 | EN25F10 | EN25LF10 | EN25P10 |
EN25S10 | ES25P10 | F25L01P | F25L0TPA | GD25D10C | GD25Q10 | GD25WD10C | 1IS25CD010 | 1IS25LQ010B | KH25L1005 | LE25FU106 | LE25FU106B
| M25P10 | M25P10-A | M25PE10 | MS25X10 | MX25L1005 | MX25L1005C | MX25L1005ZM | MX25L1006 | MX25L1006E | MX25L1021 | MX25L1021E |
MX25L1025 | MX25L1025C | MX25L1026 | MX25L1026E | MX25R1035F | MX25U1001E | MX25V1006 | MX25V1006E | MX25V1035F | NX25P10 |
PM25LD010 | PM25LV010 | PM25LVO10A | S25FL001D | SA25F010 | SST25VF010 | SST25VFO10A | SST25WF010 | TS25L010A | W25D10V | W25P10V
| W25Q10BV | W25Q10CL | W25Q10CV | W25Q10EW | W25X10AV | W25X10BL | W25X10BV | W25X10CL | W25X10L | W25X10V

A25L020 | A25L020C | A25L20P | AT25DF021 | AT25F2048 | AT25F2048N | AT25PE20 | AT25PE20[P264] | EN25B20 | EN25F20 | EN25LF20 | EN25P20
| EN25S20 | ES25P20 | F25D02P | F25D02QA | F25L02P | F25L02PA | GD25D20C | GD25Q20B | GD25Q21B | GD25WD20C | IS25LQ020 | IS25WD020 |
IS25WP020D | IS25WQ020 | KH25L2005 | LE25FU206 | LE25S20 | LE25U20 | M25P20 | M25PE20 | M25U2033E | MS25X20 | MX25L2005 |
MX25L2005C | MX25L2005ZM | MX25L2006 | MX25L2025C | MX25L2026E | MX25L26C | MX25R2035F | MX25U2032E | MX25U2033E | MX25U2035F
| MX25V2006E | MX25V2033F | MX25V2035F | NX25P20 | PM25LD020 | PM25LV020 | S25FL002D | SA25F020 | SST25VF020 | SST25VF020A |
SST25VF020B | SST25WF020 | SST25WF020B | TS25L020A | W25D20V | W25P20V | W25Q20BW | W25Q20CL | W25Q20CV | W25Q20EW | W25X20BL |
W25X20BV | W25X20CL | XM25QU20B

A25L040 | A25L040A | A25L40P | AT25DF041 | AT25DF041A | AT25F4096 | AT25FF041A | AT25FS040 | AT25PE40 | AT25PE40[P264] | AT25SF041 |
AT25XE041D | AT26F004 | EN25B40 | EN25F40 | EN25LF40 | EN25P40 | EN25Q40 | EN25S40 | EN25T40 | ES25M40 | ES25P40 | F25D04Q | F25D04QA |
F25L004 | F25L04P | F25L04PA | GD25D40C | GD25LQ40 | GD25Q40B | GD25Q41B | GD25WD40C | 1S25LD040 | 1S25LQ040B | 1IS25WD040 |
IS25WP040 | 1IS25WP040D | IS25WQ040 | KH25L4005A | KH25L4006E | LE25FS406 | LE25FU406B | LE25FU406C | LE25S40 | LE25U40 | M25P40 |

- 46 -



25..080
(8Mb)

25..016
(16Mb)

25..032
(32Mb)

M25PE40 | MS25X40 | MX25L4005 | MX25L4005A | MX25L4005C | MX25L4006E | MX25L4025C | MX25L4026E | MX25R4035F | MX25U4032F |
MX25U4033E | MX25U4035 | MX25U4035F | MX25V4005 | MX25V4005C | MX25V4006E | MX25V4035 | NX25P40 | PM25LD040 | PM25LV040 |
S25FL004 | S25FLO04A | S25FL004K | S25FL204K | SA25F040 | SST25VF040 | SST25VF040A | SST25VF040B | SST25WF040 | SST25WF040B |
W25D40V | W25P40V | W25Q40BL | W25Q40BV | W25Q40BW | W25Q40CL | W25Q40EW | W25X40AL | W25X40AV | W25X40BL | W25X40BV |
W25X40CL | W25X40L | W25X40V | XM25QH40B | XM25QU40B

A25L080 | A25L80P | AT25DF081 | AT25DF081A | AT25DL081 | AT25FF081A | AT25PE80 | AT25PE80[P264] | AT25SF081 | AT25XE081D | AT26DF081
| EN25B80 | EN25D80 | EN25F80 | EN25P80 | EN25Q80 | EN25Q80A | EN25S80 | EN25T80 | ES25M80 | ES25P80 | F25D08QA | F25L08QA | FM25Q08 |
FM25Q08A | GD25D80C | GD25LQ80 | GD25Q80B | GD25Q80C | GD25WD80C | 1IS25LP080D | IS25LQ080 | 1IS25LQ0808B | IS25WP080 | IS25WP080D |
KH25L8005 | KH25L8006E | KH25L8036D | LE25S81 | M25P80 | M25PE80 | M25PX80 | M25X80 | MS25X80 | MX25L8005 | MX25L8005ZM |
MX25L8006E | MX25L8008E | MX25L8035E | MX25L8036E | MX25L8073E | MX25L8075E | MX25R8035F | MX25U8032E | MX25U8033E | MX25U8035
| MX25U8035E | MX25U8035F | MX25V8005 | MX25V8006E | MX25V8035F | NX25P80 | PM25LV080 | PM25LV080B | S25FLO08A | S25FLO0SK |
S25FL208K | SST25VF080B | SST25WF080 | SST25WF080B | TS25L80P | W25D80V | W25P80V | W25Q40CL | W25Q80BL | W25Q80BV | W25Q80BW |
W25Q80DL | W25Q80DV | W25Q80EW | W25Q80FV | W25Q80JV | W25X80AL | W25X80AV | W25X80BV | W25X80L | W25X80V | XM25QHS80B |
XM25QU80B

A25L016 | A25L16P | A25LQ16 | AT25DF161 | AT25DL161 | AT25FF161A | AT25PE16 | AT25PE16[P528] | AT25SF161 | AT25XE161D | AT26DF161 |
EN25B16 | EN25D16 | EN25F16 | EN25P16 | EN25Q16A | EN25QA16 | EN25QH16 | EN25S16 | EN25T16 | ES25M16 | ES25P16 | F16 | F25L016 |
F25L16P | F25L16PA | F25L16Q | F25L16QA | FM25Q16 | FM25Q16A | FM25Q16B | FM25S16A | GD25LQ16 | GD25Q16B | IS25LP016D | IS25LQ0168B |
IS25WP016 | 1IS25WP016D | KH25L1605A | KH25L1605D | KH25L1606E | KH25L1635D | LE25S161 | M25P16 | M25PE16 | M25PX16 | M25X16 |
MS25X16 | MX25L1605 | MX25L1605A | MX25L1605D | MX25L1606E | MX25L1608D | MX25L1608E | MX25L1633E | MX25L1635D | MX25L1635E |
MX25L1636D | MX25L1636E | MX25L1673E | MX25L1675E | MX25R1635F | MX25U1633F | MX25U1635E | MX25U1635F | MX25V1635F | N25Q016 |
NX25P16 | PM25LV016 | PM25LV016B | Q16 | QB25F016S33B | QH25F016S33B | S25FL016 | S25FLO16A | S25FL016K | S25FL116K | S25FL216K |
SA25F160 | SST25VF016B | TS25L16AP | TS25L16BP | TS25L16P | W25Q16BF | W25Q16BV | W25Q16CL | W25Q16CV | W25Q16DV | W25Q16DW |
W25Q16FW | W25Q16JL | W25Q16JV | W25Q16VF | W25XT6AL | W25X16AV | W25X16BV | W25X16V | XM25QH16B | XM25QH16C | XM25QU16B
A25L032 | A25LQ32A | AT25DF321 | AT25DF321A | AT25FF321A | AT25QL321 | AT25SF321 | AT25SL321 | AT25XE321D | AT26DF321 | AT26SD321 |
ATXP32 | EN25B32 | EN25F32 | EN25P32 | EN25Q32B | EN25QA32 | EN25QH32 | EN25S32 | ES25P32 | F25L32P | F25L32PA | F25L32Q | F25L32QA |
F32 | FM25Q32 | FM25Q32A | GD25B32C | GD25LB32D | GD25LQ32 | GD25LQ32C | GD25Q32B | GD25Q32C | 1IS25CQ032 | IS25CQ032A | IS25LP032D |
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25..064
(64Mb)

25..128
(128Mb)

25..256
(256Mb)

IS25LQ032B | IS25WP032 | IS25WP032D | KH25L3205D | KH25L3206E | M25P32 | M25PE32 | M25PX32 | M25X32 | MX25L3205A | MX25L3205D |
MX25L3206 | MX25L3206E | MX25L3208D | MX25L3208E | MX25L3225D | MX25L3233F | MX25L3235D | MX25L3235E | MX25L3236D | MX25L3236E
| MX25L3236F | MX25L3237D | MX25L3239E | MX25L3255E | MX25L3273E | MX25L3273F | MX25L3275E | MX25R3235F | MX25U3235E |
MX25U3235F | MX25U3273F | N25Q032 | NX25P32 | Q32 | QB25F320S33B | QH25F320S33B | S25FL032 | S25FL032A | S25FL032K | S25FL0O32P |
S25FL132K | SA25F320 | SST25VF032B | W25Q32BV | W25Q32DW | W25Q32FV | W25Q32FW | W25Q32JV | W25Q32JW | W25Q32V | W25Q32VF |
W25X32AV | W25X32BV | W25X32V | XM25QH32B | XM25QH32C | XM25QU32B | XM25QW32C

A25LMQ64 | A25LQ64 | AT25DF641A | AT25QF641 | AT25QL641 | AT25SF641 | AT25SL641 | ATXP64 | EN25F64 | EN25Q64 | EN25QA64 | EN25QH64 |
EN25S64 | F25D64QA | F25L64QA | F64 | FM25Q64 | FM25Q64A | GD25B64 | GD25B64C | GD25LB64C | GD25LQ64B | GD25LQ64C | GD25Q64B |
GD25Q64C | IS25LP064 | IS25LP064A | IS25WP064 | IS25WP064A | KH25L6405D | KH25L6406E | M25P64 | M25PX64 | MT25QL064A | MT25QUO064A |
MX25L64 | MX25L6405 | MX25L6405D | MX25L6406E | MX25L6408 | MX25L6408D | MX25L6408E | MX25L6433 | MX25L6433F | MX25L6435 |
MX25L6435E | MX25L6436E | MX25L6436F | MX25L6439 | MX25L6439E | MX25L6445E | MX25L6455E | MX25L6456 | MX25L6456E | MX25L6456F |
MX25L6465E | MX25L6473E | MX25L6473F | MX25L6475E | MX25R6435F | MX25U6435 | MX25U6435E | MX25U6435F | MX25U6473 | MX25U6473F |
N25Q064 | N25Q064A11 | N25Q064A13 | Q64 | QB25F640S33B | QH25F640S33B | S25FL064A | S25FL064K | S25FL064L | S25FL064P | S25FL164K |
S25FS064S | S64 | SST25VF064C | W25Q64BV | W25Q64CV | W25Q64DW | W25Q64FV | W25Q64FW | W25Q64JV | W25Q64JW | W25Q64VF |
W25R64JV | W25R64JW | W25X64BV | W25X64V | W74M64JV | W74M64JW | XM25QH64A | XM25QH64B | XM25QH64C | XM25QU64A | XM25QU64C
| XM25QW64C | XM25RH64C | XM25RU64C

AT25QF128A | AT25QL128A | AT25SL128A | ATXP128 | EN25Q128 | EN25QA128 | EN25QH128 | EN25QH128A | F25D128QA | F25L128QA |
GD25B127D | GD25B128 | GD25LB128D | GD25LQ128 | GD25LQ128C | GD25LQ128D | GD25Q127 | GD25Q128B | GD25Q128C | IS25LP128 |
IS25LP128F | IS25WP128 | IS25WP128F | KH25L12845E | M25P128 | MT25QL128A | MT25QU128A | MX25L128 | MX25L12805D | MX25L12835E |
MX25L12835F | MX25L12836E | MX25L12839F | MX25L12845E | MX25L12845G | MX25L12850F | MX25L12855E | MX25L12855F | MX25L12865E |
MX25L12865F | MX25L12873F | MX25L12873G | MX25L12875F | MX25LM12845G | MX25U128 | MX25U12835F | MX25U12873F | MX25U12890F |
MX25UM12845G | N25Q128 | N25Q128A11 | N25Q128A13 | Q128 | S25FL127S | S25FL128K | S25FL128L | S25FL128P | S25FL128S | S25FL129P |
S25FS128S | W25Q128BV | W25Q128FV | W25Q128FW | W25Q128JV | W25Q128JW | W25R128FW | W25R128JV | W25R128JW | W74M12JV |
W74M12JW | XM25QH128A | XM25QH128B | XM25QH128C | XM25QU128C | XM25QW128C | XM25RH128C | XM25RU128C

EN25QA256 | EN25QH256 | EN25QH256A | EN25S256 | GD25B256D | GD25B257D | GD25LB256D | GD25LQ256 | GD25LQ256C | GD25LQ256D |
GD25Q256 | GD25Q257D | GD25S512MDIDIEQ] | GD25S512MDIDIET] | IS25LP256D | IS25LP256E | IS25WP256D | MT25QL256A | MT25QU256A |
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MX25L25635E | MX25L25635F | MX25L25639F | MX25L25645G | MX25L25655E | MX25L25655F | MX25L25673G | MX25L25735E | MX25L25735F |
MX25L25835E | MX25L25855E | MX25LM25645G | MX25U25635F | MX25U25645G | MX25UM25645G | N25Q256A11 | N25Q256A13 | N25Q256A33 |
N25Q256A73 | N25Q256A81 | N25Q256A83 | S25FL256L | S25FL256P | S25FL256S | S25FS256S | W25M512JVIDIEQ] | W25M512JVIDIET] |
W25Q256FV | W25Q256JV | W25Q256JW | W25Q257FV | W25Q257JV | W25R256JV | W25R256JW | W74M25JV | W74M25JW | XM25QH2568 |
XM25QH256C | XM25QU256B | XM25QU256C | XM25QW?256C | XM25RH256C | XM25RU256C

GD25Q512 | IS25LES12M | IS25LP512M | IS25WP512M | MT25QL512A | MT25QU512A | MX25L51237G | MX25L51245G | MX25L51255G |

25..512 MX25LM51245G | MX25U51245G | MX25UM51245G | MX66L51235F | MX66U51235F | S25FL512S | S25FS512S | W25Q01JV[DIEQ] | W25Q01JV[DIET]

(512Mb) | W25Q02JVIDIEO] | W25Q02JV[DIE1] | W25Q02JV[DIE2] | W25Q02JV[DIE3] | W25Q512JV | W25Q512NW | W25R512JV | W25R512NW | W74M51JV |
W74M5TNW | XM25QH512C | XM25QU512C | XM25QW512C | XM25RH512C | XM25RU512C

25..01

(16b) MT25QL01G | MT25QU01G | MX66L1G45G | W25Q01JV

25..02
MT25QL02G | MT25QU02G

(2Gb)

FLASH SPI 26... series

Supports low-voltage serial flash memories (1.8V) and standard (3.3V)

SST26VF040A | SST26WF040B | SST26WF040BA | SST26VFO80A | SST26WF080B | SST26WFO080BA | SST26VF016 | SST26VF016B | SST26WF016B |
SST26WF016BA | SST26VF032 | SST26VF032B | SST26VF032BA | SST26VF064B | SST26VF064BA | SST26VF064C | SST26VF064CA | SST26WF064C |
SST26WF064CA

(4Mb -
64Mb)

DATA FLASH SPI 45... series
MA45PE10 | AT45DB011 | AT45DB011D | M45PE20 | AT45DB021 | AT45DB021D | AT45DB021E | M45PE40 | AT45DB041 | ATA5DB041D | ATASDBO41E |
M45PES80 | ATA5DB081 | AT45DB081D | ATA5DBO8TE | M45PE16 | AT45DB161 | AT45DB161D | ATASDB161E | AT45DQ161 | ATA5DB321 | AT45DB321D |
AT45DB321E | AT45DQ321 | ATASDB641E | AT45DB642 | AT45DB642D

(IMb -
64Mb)
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FLASH SPI NAND

Supports low-voltage serial flash memories (1.8V) and standard (3.3V)

GDS5F1GQ4RB | GD5F1GQ4RC | GD5F1GQ4RE | GDSF1GQ4RF | GDS5F1GQ4UB | GD5F1GQ4UC | GDSF1GQ4UE | GDSF1GQ4UF | IS37SMLO1GT |
IS38SMLO1G1 | MT29F1GOTAAADD | MT29F1GOTABAFD | MT29F1GO1ABAGD | MT29F1GO1ABBFD | MT29F1GOTABBGD | TC58CVGOS3HRA |
(1Gb - | TC58CYGOS3HRA | W25N01GV | W25N01GW | W25N01JW | W74MO1GV | W74MO1GW | GD5F2GQ4RB | GD5F2GQ4RC | GD5F2GQ4RE | GD5F2GQA4RF |
4Gb) GD5F2GQ4UB | GD5F2GQ4UC | GDSF2GQ4UE | GDSF2GQ4UF | MT29F2GOTAAAED | MT29F2G01ABAGD | MT29F2G01ABBGD | TC58CVG1S3HRA |
TC58CYG1S3HRA | W25N02JW | W25N02KV | W74MO2KV | MT29F4AGO1ABAFD | MT29F4GO1ABBFD | MT29FAGOTADAGD | TC58CVG2SOHRA |
TC58CYG2SO0HRA

KBC FLASH

Supports ENE KB90xx

(TMb) | KB9012 | KB9016 | KB9020 | KB9022 | KB9026 | KB9028 | KB930

F-RAM I2C 24... series
FM24C04 | FM24C04B | FM24CL04 | FM24CL04B | MB85RC04V | FM24C16 | FM24C16B | FM24CL16 | FM24CL16B | FM25C160B | MB85RC16 |
MB85RC16V | FM24C64 | FM24C64B | FM24CL64 | FM24CL64B | MB85RC64 | MB85RC64A | MR44V064B | FM24V01 | MB85RC128 | MB85RC128A |
FM24V02 | FM24V02A | FM24W256 | MB85RC256V | FM24V05 | MB85RC512T | FM24V10 | FM24VN10 | MB85RCTMT | MR44V100A | MR44V200A

(4kb -
2Mb

F-RAM I2C 25... series
FM25040 | FM25040B | FM2504B | FM25CL04B | FM25L04 | FM25L04B | FM25C160 | FM25C160B | FM25L16 | FM25L16B | MR45V032A | FM25640 |
FM25640B | FM25CL64 | FM25CL64B | MB85RS64 | MB85RS64A | MR45V064B | FM25V01 | FM25V01A | MB85RS128A | MB85RS128B | FM25V02 |
FM25V02A | FM25W256 | MB85RS256A | MB85RS256B | MR45V256A | FM25V05 | MB85RS512T | FM25V10 | FM25VN10 | MB85RSTMT | MR45V100 |
CY15B102Q | CY15V102Q | FM25H20 | FM25V20 | FM25V20A | MB85RS2MLY | MB85RS2MT | MB85RS2MTA | MB85RS2MTY | MR45V200 | CY15B104Q |
CY15V104Q | MB85RQ4ML | MB85RS4MLY | MB85RS4MT | MB85RS4MTY | CY15B108Q | CY15V108Q
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SFP / SFP+ / QSFP / QSFP+ / XFP optical & ethernet modules

Please note!
- there is SFP/QSFP/XFP adapter required with external power supply,

- MSA standard is supported (e.g. SFF-8472, SFF-8636, INF-8077i),

- possibility to enter manufacturer/host password and program write protected transceivers,

- brute force password tool (searching password for protected transceivers with unknown password),

- change manufacturer info, model, serial number etc. and recalculate checksums directly from REVELPROG-IS application

SFP and SFP+, read/write block 0xAQ (256B), read block 0xA2 (256B), read/write page 0-255 (128B), standard MSA

SFP / SFP+
(MSA standard: 0xAO, 0xA2, example manufacturers: GBC, HUAWEI, GPON, JDSU, MIKROTIK, OPTEC, OPTION, WTD and other OEM
page 0-255)
QSFP / QSFP+ QSFP and QSFP+, read/write AOh block (256B), read/write 0-255 page (128B), standard MSA
(MSA standard: 0xAQ, example manufacturers: CISCO, HP, FINISAR, NOKIA, HUAWEI, JDSU and other OEM
page 0-255)
XFP XFP, read/write AOh block (256B), read/write 0-255 table (128B), standard MSA

(MSA standard: 0xAQ, example manufacturers: T0GTEK, CISCO, FINISAR, OPNEXT, JDSU and other OEM

table 0-255)

Your suggestions

If you have any suggestion for supported device list please contact us at lab@reveltronics.com. There is possibility to add any serial device
with I2C, SPI or uWire interface (EEPROM/FLASH/FRAM).
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11. APPENDIX B - video tutorials and technical support

Programming examples on youtube:

https://www.youtube.com/playlist?list=PLKdrjJPMLdS8KBX12vHdyCg 0JfNTOAw7U

REVELTRONICS' forum:

https://forum.reveltronics.com/viewforum.php?f=17
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